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Welcome to ClaroRead
Welcome to ClaroRead. ClaroRead is designed to make it easier for you to do things with
your computer by making it speak and making things easier to read. It is closely integrated
with Microsoft Word and Outlook to assist you as you work with text but also helps you with
web pages, email, and anything else you want to do.
ClaroRead adds powerful speech features which allow you to listen to any information
depicted on your computer screen. It also includes many easy ways to make the text clearer
and more visible. We have also included useful text checking tools, to aid you in creating the
most accurate documents.
ClaroRead will work with any application or software program on your PC. The highly-visible
ClaroRead toolbar can be locked in one place, docked to the top of the screen or can be left
to float around the screen as suits you best.
Full ClaroRead Toolbar
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ClaroRead Overview
ClaroRead provides an easily-readable floating toolbar that will lock onto any Windows
software application you have open and active. You can easily add or remove buttons from
this toolbar.
The speech features of ClaroRead are powerful. One of the key benefits of ClaroRead is that
it can read back menus, button text and tooltips, as well as any text displayed on screen.
The program will also instantly read back any text that you select using your mouse. It will
also read back characters, words and sentences as they are typed.
ClaroRead is available in three versions:
•

ClaroRead SE – simplified version of ClaroRead. This version is designed for exams so
does not include proofing and scanning features.

•

ClaroRead Plus – full version of ClaroRead with powerful proofing and scanning
functionality, including optical character recognition (OCR) for reading difficult text and
making accessible PDFs.

•

ClaroRead Pro – gives you more control over the scanning process, including
specialised vocabularies and output formats.

All versions of ClaroRead have the same powerful speech functions. The default toolbars
are shown above – for the full set of toolbar buttons, which can be shown or hidden as
required, see ClaroRead Toolbar Buttons.
This help system is for ClaroRead Plus and Pro. ClaroRead SE has its own simplified
help system.
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ClaroRead Toolbar Buttons
The ClaroRead Toolbar lets you use ClaroRead's powerful features at any time without
getting in your way. The full toolbar contains the following buttons:

Several toolbar buttons are hidden by default. We recommend that you hide buttons that you
do not use regularly, to make the toolbar smaller and less obtrusive.
You can show or hide buttons in View Settings as well as choosing from three different
display styles or 'skins'.

Play button
Click the Play button (or press F7) to start ClaroRead speaking:
•

In some applications, including Microsoft Word, Outlook, and Adobe Acrobat, ClaroRead
starts reading aloud from the cursor position onwards.

•

In applications that do not support speaking from the cursor, ClaroRead reads aloud the
contents of the clipboard.

ClaroRead also has mechanisms for reading text aloud automatically, that is, without clicking
Play. For example, it can read aloud any text that you select with the mouse, or read aloud
words as you type them.
See Speech Features.

Stop button
Click the Stop button to halt ClaroRead speaking. You can also click the mouse
(anywhere, it does not matter) or press the Ctrl or F8 keys to stop ClaroRead
speaking.

Dictate button
If you have Nuance’s Dragon speech recognition software (formerly Dragon
NaturallySpeaking) installed, you can use the Dictate button to turn Dragon's
microphone on or off. See Dictate Features.
This button is hidden by default.
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Font button
The Font button allows you to quickly change the font of a whole Microsoft Word
document (or a selected portion of it) to one of three more readable and popular
fonts – Comic Sans MS, Trebuchet MS, or Microsoft Sans Serif. You can also easily
increase or decrease font size, or change text colour. See Font Features.
This button is hidden by default.

Spacing button
The Spacing button allows you to quickly change the spacing between text
characters, lines and paragraphs in a Microsoft Word document. See Spacing
Features.
This button appears with the Font button and is hidden by default.

Check button
Click the Check button (or press F9) to start ClaroRead’s spelling checker.
ClaroRead’s spelling checker is tightly integrated with Microsoft Word, offering
suggested words, synonyms, and dictionary definitions to help you choose the correct
spelling. It also works in most other applications where you need to enter text. See Check
Features.

Homophones button
Click the Homophones button (or press F10) to start ClaroRead’s homophone
checker. Homophones are words that sound alike but are different in meaning, for
example blew and blue, and can be a problem for many people. ClaroRead can identify
homophones in your text and present you with suggestions that sound similar. See
Homophone Features.

Predict button
The Predict button enables word prediction, which can be a very useful tool for
certain writing styles. The ClaroRead word prediction feature contains the most
frequently-used English words. You can also train prediction to use your own vocabulary
either from a document or learning from your typing. See Word Prediction Features.
This button is hidden by default.

Save button
You can convert the text in the current Microsoft Word document or anything you
copy into the clipboard (e.g. from a web page) into an audio file or a video file to
save on your computer. Click the Save button in Microsoft Word and the current document
will be saved, or select text and copy it to the clipboard for any other source of text. See
Save Features.
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Extras button
This provides a handy link to start other selected software programs. See ClaroRead
Extras.

Scan button
The Scan button contains the following scanning options:
•

Scan from Paper – scans a paper document, with the output sent directly into a Word
document or saved to file.

•

Scan from PDF/File – scans inaccessible text, such as a non-textual PDF or an image
file, and converts it into standard text, saved to file.

•

Scan from screen – scans text from the screen, even if that text cannot be selected
normally, and sends it to the clipboard as standard text.

ClaroRead uses the powerful OmniPage Optical Character Recognition (OCR) technology to
take any text, even if it is not encoded as words and characters, and convert it into text that
can be used in your documents and read out by ClaroRead.
See Scanning Features.

Settings button
The Settings button opens the Setting dialog that lets you change all the main
ClaroRead options and settings, including Speech, View, Prediction, Check, and
Scan. See ClaroRead Settings.

Help button
Click the Help button to open the ClaroRead help system.

Undock button
When the ClaroRead toolbar is docked to the top of your screen, click the Undock
button to return it to its floating state. See Moving, Docking, and Hiding the
ClaroRead Toolbar.

Close button
Click the Close button to close ClaroRead completely.
Note that you can hide the ClaroRead toolbar temporarily using the Minimise button, Pause
key, or System Tray icon. See Moving, Docking, and Hiding the ClaroRead Toolbar.
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Moving, Docking, and Hiding the
ClaroRead Toolbar
You can use the ClaroRead toolbar in three modes:
•

Floating on top of your desktop (default)

•

Locked to the active window

•

Docked to the top of the screen

You can also hide the toolbar by minimising it to the System Tray. Many of ClaroRead’s
features continue to work while the toolbar is hidden.

Floating toolbar
By default the ClaroRead toolbar behaves like a normal window, which floats on top of your
desktop so you can always use it no matter what you are doing. You can use the title bar to
drag the toolbar to a suitable place on your desktop.
The toolbar behaves like this when the "Lock toolbar to active window" check box is
unchecked in View Settings.
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Locking the toolbar to the active window
You can lock the ClaroRead toolbar to the currently active window. The toolbar will move
automatically as you switch between different applications, always locked to the top right of
the active application's window.
To enable this behaviour, select the "Lock toolbar to active window" check box in View
Settings.

When using this mode, we recommend that you make the ClaroRead toolbar as small as
possible so that it does not block your application's menu or toolbar. The above example
shows the toolbar set to medium size with captions turned off.

Docking the toolbar to the top of the screen
If the ClaroRead toolbar is floating, you can dock it to make a toolbar all across the top of
your desktop. Click the toolbar title bar and drag it to the top of the screen. Release the
toolbar and it locks itself to the top of the screen. When docked, the toolbar always remains
in the same place, where it will not obscure your applications' buttons or menus.

Click the Undock button and the toolbar will return to its normal floating state.
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Minimising or hiding the toolbar
You can hide the ClaroRead toolbar completely by minimising it. Many of the speech and
prediction features will still work, such as speaking when you select text with the mouse or
hover over text in a web page.
The simplest way to do this is to press the Pause key, which will make the toolbar appear
and disappear. You can also use the normal Minimise button on the floating toolbar:

ClaroRead will still be running, and confirmation of this is the small ClaroRead icon sitting in
the System Tray near to your clock, usually at the bottom right of your screen:

Clicking this icon gives you another way to control the ClaroRead toolbar:
•

Left-click – the toolbar appears.

•

Right-click – the toolbar disappears.

•

Double right-click – ClaroRead closes completely.
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Speech Features
ClaroRead’s ability to make the computer talk is one of its key innovative features.
ClaroRead uses high-quality synthesised voices, such as RealSpeak or Vocalizer voices
from Nuance (formerly Scansoft). ClaroRead will also work with any other text to speech
synthesiser voices that may be installed on your computer so long as they comply with the
SAPI5 standard.
ClaroRead offers a range of different speech features, which are described below. Some
speech features depend on the application that you are using. For example, you can simply
position the cursor in a Microsoft Word document and click Play, whereas in Windows
Notepad you need to select text with your mouse.
Generally, you can control ClaroRead’s speech using the toolbar’s Play and
Stop buttons. Alternatively, you can press F7 (Play) and F8 (Stop). ClaroRead
also stops speaking when you press Ctrl or the spacebar.
ClaroRead’s speech is highly configurable. You can enable or disable individual speech
features, or change the way they behave. See Speech Settings and Advanced Speech
Settings.

Click and play
In some applications, you can position the cursor and click Play. ClaroRead starts reading
aloud from the cursor position onwards, highlighting text as it reads it. These applications
include Microsoft Word and Outlook, LibreOffice Writer, Adobe Acrobat, and Internet
Explorer.
If you hold down Shift and click Play (or press Shift+F7), ClaroRead reads only a single
sentence.

Speak from the clipboard
For applications that do not support speaking from the cursor, clicking Play without anything
selected results in ClaroRead reading aloud the text that is currently stored in the Windows
clipboard.
To use this feature quickly, you can select text, press Ctrl+C to copy it to the clipboard, and
then press F7 to speak it using ClaroRead.

Speak when mouse selects
ClaroRead automatically reads aloud any text that you select with the mouse. This works in
most applications and is often the most convenient way to speak text.

Speak word on Ctrl+hover
If you hold down the Ctrl key and hover the mouse pointer over any word on your screen,
ClaroRead reads that word aloud. This works for toolbar buttons, menu items, hyperlinks,
and so on.
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Speak under mouse
ClaroRead can automatically read any text that you hover your mouse pointer over. This
includes paragraphs, hyperlinks, buttons, and alternative text for pictures.
By default, this feature is available in some web browsers, including Internet Explorer and
Mozilla Firefox. While you can configure ClaroRead to speak under the mouse for all
applications, this can be distracting.

Speak when the cursor moves
When you press your keyboard’s arrow keys to move the cursor through text, ClaroRead
automatically reads out that text:
•

Pressing Right or Left moves the cursor to the next or previous character and
ClaroRead reads out that character.

•

Pressing Ctrl+Right or Ctrl+Left moves the cursor to the next or previous word and
ClaroRead reads out that word.

•

Pressing Down or Up moves the cursor to the next or previous line and ClaroRead
reads out that entire line.

•

Pressing Ctrl+Down or Ctrl+Up moves the cursor to the next or previous paragraph and
ClaroRead reads out that whole paragraph.

You can use these commands repeatedly, for example pressing the Down arrow repeatedly
to read through a document.
You can configure ClaroRead to speak phonetic letter sounds rather than characters when
you press the Right and Left arrow keys.

Echo text as you type
ClaroRead automatically reads aloud every word that you type, immediately after you type it.
This is great for confirming that you have typed the word that you intended, but note that you
may type quicker than ClaroRead can speak!
You can also configure ClaroRead to echo sentences or individual characters.

Echo dictated text
If you use Nuance’s Dragon speech recognition software, ClaroRead echoes each word,
phrase, or command that Dragon recognises. This gives you confidence that Dragon has
correctly recognised what you said, or draws your attention to any misrecognitions.
See Dictate Features.
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Making Word and Outlook Speak
Microsoft Word and Outlook support a wide range of ClaroRead speech features:
•

Click and play (with text highlighting)

•

Speak when mouse selects (no highlighting)

•

Speak word on Ctrl+hover

•

Speak under mouse (if enabled)

•

Speak when the cursor moves

•

Echo text as you type

Note that ClaroRead temporarily changes text colour and background when highlighting text.
For some documents this may affect existing formatting.

Play On mode
If you position your cursor in a Word document and hold down Ctrl while you click
Play (or press Ctrl+F7), ClaroRead enters Play On mode and the Play button
changes appearance.
ClaroRead will continue reading the contents of your document until you click Stop, even if
you switch to another application. You can even edit the original document while ClaroRead
is reading it out.

Keyboard shortcut toggle
ClaroRead uses its own keyboard shortcuts, which can conflict with Word and Outlook’s own
shortcuts. For example, F9 opens ClaroRead’s Check window whereas you might want to
use Word’s F9 shortcut to update document fields.
To use a Word or Outlook keyboard shortcut, press F6 to switch between ClaroRead’s
shortcuts and Word’s or Outlook’s. To switch back, click the ClaroRead toolbar and then
press F6 again.

Other word processors
Other word processors, such as Apache OpenOffice and LibreOffice Writer, support some of
the same ClaroRead speech features as Word. These may include “click and play” and the
Play On mode.
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Making PDF Documents Speak
Adobe Acrobat and Adobe Acrobat Reader support a similar range of ClaroRead speech
features to Word:
•

Click and play (with text highlighting)

•

Speak when mouse selects (no highlighting)

•

Speak word on Ctrl+hover

•

Speak under mouse (if enabled)

Unlike Word, you cannot use “speak when the cursor moves”, echo text, or Play On mode in
a PDF document.
Some PDFs are inaccessible, that is, they contain images of text rather than characters and
words. The above speech features will not work for inaccessible PDFs – instead, you can
use ClaroRead’s scanning features to convert them into accessible PDFs, with text that can
be read aloud, copied into other documents, and so on.
Note, however, that PDF files are very complex, which can sometimes cause problems for
ClaroRead (and all assistive technology).
See Scanning Features and Making Accessible PDFs.
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Making Web Pages Speak
Some web browsers support more ClaroRead speech features than others. While Internet
Explorer supports the most features by default, ClaroRead has extensions for Google
Chrome and Microsoft Edge that enable a wide range of its features.
We recommend that you use Chrome or Edge as your browser, with the corresponding
ClaroRead extension installed.

Google Chrome
To use ClaroRead with Chrome, you need to have the ClaroRead Chrome extension
installed. This extension replicates many of ClaroRead’s features in Chrome, with its own
simplified version of the ClaroRead toolbar:

ClaroRead Chrome can read out web pages, PDFs and Google Docs documents. Its range
of speech features includes:
•

Click and play (with text highlighting)

•

Speak when mouse selects (no highlighting)

•

Speak under mouse

•

Echo text as you type (in text fields)

These are all available as standard, as are word prediction and screen tinting.
For more details, see the ClaroRead Chrome page on our website.

Accessing ClaroRead Chrome
ClaroRead Chrome may have been installed with ClaroRead, in which case you will see the
icon at the top right of your Chrome window:

Click
to show the ClaroRead Chrome toolbar. You may be prompted to reload the
current web page. Note that if you already have ClaroRead running, the main ClaroRead
toolbar will control the ClaroRead Chrome extension.
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If you do not see the
icon, click the Extensions icon
been installed but is not visible.

to see if ClaroRead Chrome has

If you do not have ClaroRead Chrome installed, you can find it in the Chrome Web Store.

Premium features
ClaroRead Chrome’s premium features include a spelling and homophone checker,
scanning (with OCR), speech recognition, Claro Capture integration, and access to Claro
Software’s high-quality synthesised voices.
To access premium features, you may need to sign in to your Claro account (in ClaroRead
Chrome’s settings) or make an additional purchase.

Microsoft Edge
To use ClaroRead with Edge, you need to have the ClaroRead Edge extension installed.
This extension replicates many of ClaroRead’s features in Edge, with its own simplified
version of the ClaroRead toolbar:

ClaroRead Edge has similar functionality to ClaroRead Chrome.
ClaroRead Edge may have been installed with ClaroRead. If it is not installed, you can find it
in the Microsoft Edge Add-ons store.
For more details, see the ClaroRead Edge page on our website.

Microsoft Internet Explorer
Internet Explorer supports a wide range of ClaroRead speech features:
•

Click and play (with text highlighting)

•

Speak when mouse selects (no highlighting)

•

Speak word on Ctrl+hover

•

Speak under mouse (enabled by default)

•

Echo text as you type (in text fields)

When you click the Play button with nothing selected, ClaroRead reads aloud from the top of
the current web page, with text highlighting, in an order related to how that page has been
built.
If you click on a paragraph and then click Play, ClaroRead reads aloud from the start of that
paragraph.
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Mozilla Firefox and Other Browsers
Other browsers, including Firefox, support fewer of ClaroRead’s speech features. For
example, they do not support “click and play” – when you click the Play button, ClaroRead
reads out the contents of the clipboard (“speak from the clipboard”) rather than the current
web page.
However, speech features like “speak under mouse”, “speak when mouse selects” and
“speak word on Ctrl+hover” may work on other browsers.
If you cannot use Edge, Chrome, or Internet Explorer, we recommend that you test out
ClaroRead’s speech features in your browser so that you know which ones you can use.
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Making Other Applications Speak
You can make almost any application speak using the following ClaroRead speech features:
•

Speak when mouse selects

•

Speak word on Ctrl+hover

•

Speak under mouse (if enabled)

•

Speak from the clipboard

Many applications that support text entry will also support one or more of the following
speech features:
•

Speak when the cursor moves

•

Echo text as you type

For example, ClaroRead will read out text that you select in Microsoft Excel. In Windows
Notepad, it will also speak as you move your cursor and echo your typing.
Experiment with the applications you use regularly to find the best way to use them with
ClaroRead. Don’t forget that you can also configure ClaroRead’s speech settings to suit the
way you work.

Muting ClaroRead
ClaroRead may speak a lot when you do not need it, which can be distracting. You can mute
ClaroRead temporarily by pressing Ctrl+F8.
When muted, ClaroRead’s system tray icon shows a cross,

.

Press Ctrl+F8 again to unmute ClaroRead.
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Dictate Features
You can enable the Dictate button in ClaroRead’s View Settings.
ClaroRead is often installed alongside Nuance’s Dragon speech recognition software
(formerly Dragon NaturallySpeaking). This provides a complete end-to-end solution for users
who have difficulty using their keyboard and screen – you can dictate text using Dragon, and
then use ClaroRead to help you check and edit it.
If you have Dragon installed, you can use the ClaroRead toolbar’s Dictate button to
control Dragon’s microphone.
You can also use ClaroRead to “echo” each word or phrase that Dragon recognises.

Controlling Dragon’s Microphone
If you have Dragon installed, you can use the ClaroRead toolbar’s Dictate button to control
Dragon’s microphone. This helps you to use Dragon alongside ClaroRead, without having
another toolbar on-screen.
The Dictate button changes to reflect the current status of Dragon’s microphone, and can be
used to turn the microphone on or off:
Microphone Off
Click Dictate to turn on Dragon’s microphone.
Microphone On
Click Dictate to turn off Dragon’s microphone.
Microphone Asleep
Click Dictate to turn off Dragon’s microphone.
When the microphone is turned on, you can use the full range of Dragon’s dictation
commands. As well as dictating and editing text, you can use your voice to control Windows,
browse the web, and work in applications including Microsoft Office.
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Echoing Dragon Voice Input
ClaroRead can “echo” each word or phrase that Dragon recognises. This helps provide user
confidence, as well as accuracy of dictation, by confirming that Dragon has recognised your
speech correctly. If your speech has not been recognised correctly, the echo helps to draw
your attention to the misrecognition.
You need to configure both Dragon and ClaroRead to use this feature:
•

In Dragon, turn on the Results Box.
Click Tools > Options and then open the Appearance tab. Select the “Show preliminary
results” check box. We also recommend setting “Auto-hide delay” to “Never hide”.

•

In ClaroRead, check that the echo feature is enabled.
Open ClaroRead’s Advanced Speech Settings and make sure that the “Echo Dragon
voice input” check box is selected. It is enabled by default.

Now, when you dictate text or a command, Dragon shows what it has recognised in the
Results Box, which ClaroRead then reads aloud.
Note that the echo feature works best with a headset or headphones – otherwise, Dragon
may recognise ClaroRead’s speech and go into a loop, repeating the original dictation
endlessly.
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Font Features
You can enable the Font button in ClaroRead’s View Settings.
Changing font size, typeface and colour can often make text easier to read. When
working in Microsoft Word, click ClaroRead’s Font button to open the following
menu:

Select an option to make a quick change to your document’s text.
If you have text selected, the option will only be applied to the selected text – otherwise, it
will be applied to the entire document.
Note that any changes you make using the Font menu will override or otherwise affect your
document’s existing formatting.

Increase Font Size
Increases the size of the selected text (or all text in the document) by 2 points.
If your text includes different text sizes, it will all be set to the same size – that is, the size of
the first selected text (or the text at the cursor position) plus 2 points.

Decrease Font Size
Decreases the size of the selected text (or all text in the document) by 2 points.
If your text includes different text sizes, it will all be set to the same size – that is, the size of
the first selected text (or the text at the cursor position) minus 2 points.

Comic Sans MS / Trebuchet MS / Microsoft Sans Serif
Changes the font of the selected text (or all text in the document) to Comic Sans MS,
Trebuchet MS, or Microsoft Sans Serif.
These three fonts are available by default because many people find them easy to read. You
can change the fonts shown in the Font menu using ClaroRead’s Advanced Settings Editor.
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Foreground Colour
Changes the colour of the selected text (or all text in the document).
When you click this option, a set of colours is displayed:

Select a colour to apply it to your text.
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Spacing Features
You can enable the Spacing button in ClaroRead’s View Settings.
Changing spacing and text width can make text easier to read. When working in
Microsoft Word, click ClaroRead’s Spacing button to open the following menu:

Select an option to make a quick change to your document’s spacing. Some examples of
modified character and line spacing are shown below:

If you have text selected, the option will only be applied to the selected text – otherwise, it
will be applied to the entire document.
Note that any changes you make using the Spacing menu will override or otherwise affect
your document’s existing formatting.
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Change Character Spacing
Expands character spacing by 1 point, then 2 points, and then 3 points. If clicked again,
character spacing returns to normal.
If your text includes different character spacings, it will all be set to the same spacing – that
is, the spacing of the first selected text (or the text at the cursor position) plus 1 point.

Change Line Spacing
Changes line spacing to 1 line, then 1.5 lines, then 2 lines. If clicked again, line spacing
returns to 1 line.
If your text includes different line spacings, it will all be set to the same spacing.

Change Paragraph Spacing
Changes the spacing after each paragraph to zero, then 6 points, then 12 points, then 18
points, then 24 points. If clicked again, paragraph spacing returns to zero.
If your text includes different paragraph spacings, it will all be set to the same spacing.

Change Text Width
Changes the text column to a single narrow column, then two columns, and then back to a
single wide (whole-page) column.
This option always changes the entire document.
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Check Features
ClaroRead provides a single Check button (F9) to find and correct spelling mistakes.
To help you make the right correction, ClaroRead’s Check window offers suggested
words, synonyms, and dictionary definitions. It can also give short meanings and
identify homophones.
The Check window works in almost any application – not just word processors but also email
clients, web browsers, and anywhere else that you need to enter text. Note that the
procedure for checking spelling in Microsoft Word is different to other applications.
In addition to the Check window, ClaroRead has a speaking dictionary tooltip that gives a
spoken definition for any word in any application. If you have a multilingual system, the
dictionary tooltip can also translate text quickly and easily.
You can configure the behaviour of the Check window and dictionary tooltip, or edit
ClaroRead’s list of spelling corrections. See Check Settings and the Advanced Settings
Editor.
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Checking Spelling in Word
Microsoft Word has its own powerful spelling and grammar checker, which marks errors in
your document with red and blue wavy lines. ClaroRead’s spelling checker is designed to
work alongside Word’s functionality – you can already see which words need attention, so
you can go straight to them and make corrections.
To check spelling in Word:

1. Position the cursor in a word and then click

(or press F9).

ClaroRead checks the word and the Check window appears.
If the word is incorrectly spelled, the Check window shows the Spelling tab:

If the word is already spelled correctly, the Check window still appears but it shows the
Meanings tab, enabling you to check the meaning of the word or find a synonym for it.
Proceed to step 3.
2. In the Spelling tab, you can:
•

Select a suggestion or synonym (or type your own correction into the Word field) and
then click Change. ClaroRead applies the correction and the Check window shows
the Meanings tab for the new word.

•

Click Ignore to proceed to the next misspelled word without making a correction.

•

Click Close to close the Check window without making a correction.
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3. In the Meanings tab, either:
•

Select a meaning or synonym and then click Change. ClaroRead applies the
correction and the Meanings tab updates to show details of the new word.

•

Click Close to close the Check window and end the spellcheck.

Spell Check All
If at any point you click the Spell Check All button, at the bottom of the Check window,
ClaroRead starts checking your entire Word document from the beginning. When in “spell
check all” mode:
•

When you click the Change button, ClaroRead proceeds to the next misspelled word,
rather than showing the Meanings tab for the current word.

•

The Change All button is available. Click this button to apply the selected correction to
every occurrence of the misspelled word in your entire document.

•

The Ignore All button is available. Click this button to ignore all occurrences of the
current word in your entire document.

Special Features for Word
ClaroRead’s spellcheck behaves differently in Microsoft Word, compared to how it works in
other applications.
The following features only apply when you are working in Microsoft Word:
•

Quick single-word checking
Instead of selecting text, just position the cursor in a word (or select a single word) and
then click Check (or press F9).
If the word is misspelled, the Check window will help you to correct it (using the Spelling
tab). If the word is spelled correctly, however, the Check window shows its meaning and
other information (in the Meaning tab).

•

Spell Check All button
When checking a word, you can click the Check window’s Spell Check All button to
check your entire Word document from the beginning.

•

Corrections are applied immediately
Unlike other applications (where corrections are only made when you the Check window
closes), spelling corrections in Word are made immediately, that is, as soon as you click
Change or Change All.
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Checking Spelling in Other Applications
In all applications apart from Microsoft Word, you must select text before you can check its
spelling.
To check spelling in applications other than Word:

1. Select the text that you want to check, and then click

(or press F9).

ClaroRead checks the selected text. If it finds an error, the Check window appears,
showing the Spelling tab:

If ClaroRead does not find any errors, a “No Spelling Errors!” message is displayed.
Click OK to close the message.
Note that you should always select a meaningful amount of text. This gives context,
which helps ClaroRead to identify more complex errors such as incorrectly used
homophones.
2. In the Check window, select the appropriate suggestion or synonym (or type your own
correction into the Word field), and then click Change or Change All.
Remember that, if the error is related to homophones, the Check window also shows the
Homophones tab, which can help you work out the correct homophone to use.
Alternatively, click Ignore or Ignore All to skip past that error.
3. ClaroRead continues checking the selected text. If any more errors are found, they will
be shown in the Check window.
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Note that any corrections are stored for now – they will not be applied until the spell
check is complete.
4. Continue making corrections until no errors are found.
After the last error, ClaroRead closes the Check window and applies all your corrections
as a single action.
Finally, a “No Spelling Errors!” message is displayed.
5. Click OK to close the message and return to your application.
Note that you can also click the Close button to close the Check window before the
spellcheck is complete. ClaroRead will apply any corrections that you have selected so far.

Selecting Text for Context
ClaroRead’s spellcheck looks for words that have been used incorrectly as well as words
that have been misspelled. In order to do this, it needs some context, which you can supply
by selecting more than just one word.
For example, consider the following sentence:
I tried to hand in my report but no-one was their.
The “their” is an incorrect homophone – “there” is the correct word to use in this instance.
If you select only “their”, ClaroRead will not find any mistakes. However, if you select the
whole sentence, or even part of it, ClaroRead will have enough context to recognise that the
wrong homophone has been used.
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Check Window
When ClaroRead detects a spelling mistake, it shows the Check window’s Spelling tab:

Word field
The word currently being corrected.
If none of the suggestions or synonyms is suitable, you can edit the misspelled word directly
by typing in this field.
Anything you type here becomes the “selected correction” and other parts of the window are
updated automatically. For example, if you are correcting the word “repport” and you type
“reports”, the Definition area updates to show the meaning of the word “reports” and the
picture changes from one report to several.

Suggestions list
A list of suggested corrections. The first suggestion is selected by default.
Click a suggestion to update the rest of the Check window accordingly.

Synonyms list
A list of synonyms for the selected suggestion, that is, other words with the same (or almost
the same) meaning.
Click a synonym to make that the “selected correction” (instead the selection from the
Suggestions list) and update the rest of the Check window accordingly.
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Picture
If there is a picture associated with the selected correction, it is shown to the right of the
Suggestions list.

Definition area (top right)
The dictionary definition of the selected correction is shown at the top right of the Check
window.

Context area (bottom right)
The text being spellchecked is shown at the bottom right of the Check window, with the
selected correction in bold. This shows you how the correction looks in your original text.

Syllabification area (bottom left)
At the bottom left of the Check window is the syllabification of the selected correction, that is,
how the word is split into syllables.

Lookup button
Click Lookup to look up the selected suggestion or synonym in an online dictionary.

Mute / Unmute button
ClaroRead automatically reads out anything that you select or hover the mouse pointer over
in the Check window.
Click

to disable this feature, or click

to enable it again.

Hide / Show button
You can make the Check window simpler by hiding the right side of the window, that is, the
Definition area, Context area, and Lookup button.
Click

to hide the right side of the window, or click

to show it again.

Add button
Click Add to add the spelling in the Word field to your custom dictionary. ClaroRead will now
recognise it as a correct spelling.
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Change and Change All buttons
After you have selected a suggestion or synonym (or typed your own correction into the
Word field), click Change to apply the correction.
Alternatively, click Change All to change every instance of the misspelled word in the entire
document (Word) or in the selected text (other applications).

Ignore and Ignore All buttons
You can click Ignore to proceed to the next misspelled word without making a correction.
Alternatively, click Ignore All to ignore every instance of the misspelled word in the entire
document (Word) or in the selected text (other applications).

Spell Check All button (Word only)
If you are working in Microsoft Word, click this button to spell check your entire document,
starting from the beginning.

Close button
Click Close to close the Check window immediately, applying any corrections that you have
selected so far.
Note that the Check window closes automatically when you complete a spellcheck, that is,
after you have gone through all corrections in the document (Word) or in the selected text
(other applications).
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Homophones Tab
If ClaroRead identifies a misspelling as a possible misused homophone, for example if you
have typed “their” instead of “there”, it will be shown in the Check window so you can check
it and make a correction, if necessary.
In this case, the Check window will show the Homophones tab in addition to the Spelling tab:

The Homophones tab is similar to the Spelling tab, but shows possible alternative
homophones and their meanings, rather than suggestions and synonyms.
You can still change the current word in the Homophones tab. Select an alternative
homophone, and then click Change.
See Homophone Features.
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Meanings Tab
If you are working in Microsoft Word and click Check when the cursor is positioned in a
correctly-spelled word, the Check window shows the Meaning tab instead of the Spelling tab:

The Meanings tab is similar to the Spelling tab, but shows possible meanings of the current
word, rather than suggested corrections.
You can still change the current word in the Meanings tab. Select a meaning or a synonym,
and then click Change.
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Blank Check window
If ClaroRead does not have additional meanings or synonyms for the current word, a
partially blank Check window may be shown instead of the Meanings tab:

This typically happens for technical terms, names of people or places, or custom words that
have been added to your Word dictionary.
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Dictionary Tooltip
ClaroRead provides you with a speaking dictionary tooltip that gives you a spoken
definition for any word in any program.
Either select a single word with your mouse, or hold down the Ctrl key and hover your
mouse pointer over it. A dictionary tooltip appears:

If you have “speak when mouse selects” enabled, you will also hear the selected word
spoken aloud.
The tooltip contains a definition for the selected word. To hear the definition read aloud, point
your mouse at the tooltip. If you click a word in the definition, it will in turn be defined.
The syllabification of the selected word is also shown at the top of the tooltip, if available.
The tooltip is limited to three lines of definition text – use the scroll bar at the right to read
longer definitions.
We recommend that you select words by clicking and dragging your mouse. The tooltip may
not appear if you double-click a word, for example, or if you select it using your keyboard.
You can look up the word in an online dictionary by clicking the tooltip’s Lookup button
The tooltip remains visible until you click its Close button
tooltip to a new location.

.

. Alternatively, you can drag the

By default, the tooltip stays in one place. If you prefer it to move with your cursor, select the
“Tooltip follows cursor” check box in ClaroRead’s Check Settings.
To turn off dictionary tooltips, deselect the “Use dictionary tooltip” check box in ClaroRead’s
Check Settings.
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Tooltip Translations
You can use ClaroRead’s dictionary tooltip to translate text automatically between your
system language and a second language.
To enable tooltip translations:
1. Open ClaroRead’s Settings window.
2. Select a second language from the Language drop-down list:

The list contains a preconfigured set of second languages for your system language. For
some languages, it does not appear by default.
For more details, see Language Selection.
3. Open the Check tab and make sure that the “Use dictionary tooltip” check box is
selected.
4. If you want to translate whole phrases or sentences, select the “Translate phrase
(online)” check box.
Note that ClaroRead uses an Internet translation service to translate multiple word
selections.
5. Click OK to close the Settings window.
After tooltip translations have been enabled, ClaroRead’s dictionary tooltip automatically
translates selected text from your second language into your system language. If you select
a single word, its definition is also shown in your second language.
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For example, if your system language is Swedish and you select English as your second
language, ClaroRead’s dictionary tooltip behaves as follows:
•

Single word selected
If you select a single English word (or control-and-hover over it), the tooltip shows
possible Swedish translations of that word, along with its definition in English:

If you hover your mouse pointer over the tooltip, you can hear the definition spoken
aloud, using the voice selected for your second language (in this case, English).
•

Multiple words selected
If you select multiple English words, the tooltip automatically translates the selected
phrase or sentence into Swedish:

If you hover your mouse pointer over the tooltip, you can hear the translated text spoken
aloud, using the voice selected for your system language (in this case, Swedish).
Note that the “Translate phrase (online)” check box must be selected for multiple word
selections to be translated. You must also have a working Internet connection.
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Homophone Features
The ClaroRead toolbar contains a Homophones button (F10) to help you use
homophones correctly.
ClaroRead’s homophone checker works within the Check window to identify
homophones as part of a spelling check – it will highlight homophones, both correct and
incorrect, as well as any spelling errors it finds.
Like ClaroRead’s Check window, the homophone checker works in many applications, with
some differences when you are using Microsoft Word.
If you rarely get a specific homophone wrong, you can exclude it from ClaroRead’s
homophone checker. You can also add homophones to ClaroRead’s list or delete them
entirely. See Check Settings and the Advanced Settings Editor.

About homophones
A homophone is a word that is pronounced the same as another word but differs in meaning.
The words may be spelled the same, such as rose (flower) and rose (past tense of rise), or
differently, such as to, two, and too. Or there, their, and they’re.
Homophones can be a problem for many people – misused homophones, such as using
they’re instead of there, are not incorrect spellings and therefore are not always spotted by
standard spelling checkers, dictionaries or read-back features.
ClaroRead can identify the words in your text that are homophones and present you with a
list of suggestions that sound similar.
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Checking Homophones in Word
In Microsoft Word, ClaroRead’s homophone checker (Homophones button) behaves slightly
differently to its spelling checker (Check button). It gives you an in-depth check of your
document, rather than a quick check for a single word or sentence. This can be slow as
ClaroRead will prompt you to check a lot of words – we recommend that you use the
homophone checker as a final check, for example before submitting an important essay.
To check homophones in Word:

1. Position the cursor in a word and then click

(or press F10).

ClaroRead starts checking from the current cursor position. When it finds a homophone
or a spelling mistake, the Check Window appears:

The tabs displayed in the Check window depend on nature of the current word:
•

Correctly-used homophone – Homophones tab.

•

Incorrectly-used homophone – Spelling tab shown, Homophones tab available.

•

Spelling mistake – Spelling tab.

The Meanings tab may also be displayed.
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2. Either:
•

Make a correction and click Change or Change All. ClaroRead applies the correction
immediately and proceeds to the next homophone or spelling mistake.

•

Click Next, Ignore, or Ignore All to proceed to the next homophone or spelling
mistake.

3. ClaroRead continues checking the document for homophones and spelling mistakes. If it
finds any, they will be shown in the Check window.
4. Continue making corrections (or clicking Next and Ignore).
5. When ClaroRead reaches the end of the document, it closes the Check window and
shows a message, for example “Finished checking homophones”.
6. Click OK to close the message and return to Word.
Note that you can click the Check window’s Close button at any time to end the homophone
check.
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Checking Homophones in Other Applications
In all applications apart from Microsoft Word, you must select text before you can check
homophones.
To check homophones in applications other than Word:

1. Select the text that you want to check, and then click

(or press F10).

ClaroRead checks the selected text. If it finds a homophone or spelling mistake, the
Check Window appears:

The tabs displayed in the Check window depend on nature of the current word:
•

Correctly-used homophone – Homophones tab.

•

Incorrectly-used homophone – Spelling tab shown, Homophones tab available.

•

Spelling mistake – Spelling tab.

The Meanings tab may also be displayed.
2. Either:
•

Make a correction and click Change or Change All. ClaroRead stores the correction
and proceeds to the next homophone or spelling mistake.

•

Click Next, Ignore, or Ignore All to proceed to the next homophone or spelling
mistake.
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3. ClaroRead continues checking the selected text for homophones and spelling mistakes.
If it finds any, they will be shown in the Check window.
Note that any corrections are stored for now – they will not be applied until the
homophone check is complete.
4. Continue making corrections (or clicking Next or Ignore).
5. When ClaroRead reaches the end of the selected text, it closes the Check window and
applies all your corrections as a single action.
6. Finally, a message appears, for example “Finished checking homophones”.
7. Click OK to close the message and return to your application.
Note that you can click the Check window’s Close button at any time to end the homophone
check. ClaroRead will apply any corrections that you have selected so far.
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Word Prediction Features
You can enable the Predict button in ClaroRead’s View Settings.
ClaroRead contains a powerful word prediction feature, which can be helpful for your
personal problem words, new vocabulary, poor spellers, foreign-language speakers,
and people with problems using a keyboard. Click the Predict button to toggle word
prediction on and off.
ClaroRead tries to predict the words you want to use next in a sentence. It learns these
words as you type them, and will make suggestions based on previous documents. It takes
into consideration the frequency and order in which you use certain words, to help you
construct sentences quickly and easily.
The words that appear depend on your selected prediction dictionary. You can choose
subject-specific dictionaries, like Accountancy or Biology, use a small prediction dictionary of
common English words, use your own prediction dictionary, or use a large English dictionary
of 100,000 words.
ClaroRead’s word prediction is highly configurable. As well as selecting a prediction
dictionary (or even creating your own), you can choose between several prediction styles,
set the number of letters needed for word prediction, control how the Prediction List looks,
and so on. See Prediction Settings and the Advanced Settings Editor.

Using Word Prediction
To activate word prediction, click the
that prediction is on.

button. The button turns orange

to indicate

Now, when you start typing in any application, a small Prediction List appears:

The Prediction List shows the five most likely words, based on the letters that you have
already typed. Where available, small pictures are shown to help you choose words quickly.
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To insert one of the predicted words into your document, either press the corresponding
function key (F1 to F5), or click the word with your mouse. ClaroRead inserts the selected
word and automatically adds a space in preparation for the next word.
If the word you want is not displayed, either type more letters, or click the
bottom of the Prediction List.

arrow at the

By default, the Prediction List appears at a fixed position on your screen. As it always
appears in the same place, you know where to look for a word prediction. You can drag it to
a new position, for example to keep it in your eyeline when working in a different application.

Prediction wildcards
You can use wildcards in predictions, that is, symbols that can be used to represent any
character. ClaroRead’s word prediction supports the following wildcards:
•

_ (underscore) – use to represent one or more characters.

•

* (asterisk) – use to represent a single character.

For example, when you type “h_e”, predicted words may include horse, home, and hope –
any number of characters may be between the h and the e. The e may not be the last
character in the word, so words like however and himself may also appear, depending on
the selected prediction style.
When you type “h*t”, all predicted words will have a single letter between the h and the t, for
example hat, hit, and hot. Words like hotel and hitting may also appear.

Using F1–F5 in other applications
If ClaroRead is using the F1, F2, F3, F4 and F5 keys for word prediction, you cannot use
them in other applications, for example to open an application’s help. If you want to bypass
ClaroRead’s word prediction and use a function key with the current application, press F6
first and then your choice of F1 to F5.

Prediction List Options
You can right-click the Prediction List to open a menu showing its options:
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You can choose between four prediction styles:
•

Completion (c > cat)
This is a conventional word prediction style, which predicts words based on exactly what
you type.
For example, if you type the letter “c”, words like cat and celery might appear in the
Prediction List.

•

Phonetic (k > cat)
This is the default style, and predicts words based on how they sound rather than how
they are spelled.
For example, if you type the letter “k”, words that might appear include cat, competition,
and cow, all of which start with a “k” sound, despite being spelled with a “c”.
This style is good for people who can spell phonetically but are not good with irregular
spellings.

•

First and Contains (gdt > graduate)
This style matches the first letter you type, and then the ones after it in order, anywhere
in the word.
For example, if you type the letters “gdt”, words that might appear include graduate,
grandfather, and goodnight.
This style is good for people who usually get the first letter right but are not sure what
comes afterwards, although they can usually guess or remember some more letters.

•

Contains Anywhere (ptg > sporting)
This style matches the letters you type anywhere in a word, in any order.
For example, if you type the letters “ptg”, words that might appear include sporting,
copyright, stopping, and photographs.
This style is especially helpful for people who really struggle with spelling, bringing up the
most suggestions and the widest range of matches. However, as it brings up so many
suggestions, it is best used with a small prediction dictionary.

You can also enable “Window follows cursor”. Rather than the Prediction List appearing at a
fixed position on your screen, it will appear just below your cursor, in any application that you
use.
Note that many more word prediction settings are available, including how the Prediction List
looks and how prediction behaves. See Prediction Settings.
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Save Features
ClaroRead can save text as an audio or video file so that you can listen to it later.
For example, you might have notes from a lecture that you want to listen to on your
mobile device while you’re on your way to college.
Click the Save button on the ClaroRead toolbar to show the available options:

•

Save as Audio – saves text to an audio file, e.g. an MP3.

•

Save as Video – saves text to a video file, with the text displayed using a configurable
font and background as it is read out.

When you click a Save option, the text that is saved to audio or video depends on the
application you are using. For example:
•

Microsoft Word – ClaroRead saves the selected text to audio or video. If nothing is
selected, it saves the entire document.

•

Adobe Acrobat – ClaroRead saves the currently displayed page of the PDF to audio or
video.

•

Web browsers and most other applications – ClaroRead saves the contents of the
Windows clipboard to audio or video. For example, to save text from Google Chrome,
you need to copy it to the clipboard before you click Save on the ClaroRead toolbar.

The text is read out using your standard voice, speed, and so on, as configured in
ClaroRead’s Speech settings.

48

Saving Text as Audio
The Save as Audio option saves the selected, displayed, or copied text to an audio file.
To save text as audio:
1. Depending on the application you are using, select text or copy it to the clipboard.

2. Click

and then Save as Audio.

The standard Save As window appears.
3. Enter a location and name for the audio file.
4. Select a file format from the “Save as type” drop-down list.
Available formats are MP3 (.mp3), Windows Media Audio (.wma), Waveform Audio
(.wav), and Ogg Vorbis (.ogg).
Use the format that works best with your computer’s media player or your portable audio
device – while .wav files work on the largest range of devices, for example, they are
much larger than .mp3 files.
5. Click Save.
ClaroRead shows a progress bar while it saves your text to the specified audio file. For
long documents, this can take a significant amount of time.

Note that you can also save text as audio using the
settings.

button, in ClaroRead’s Speech
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Saving Text as Video
The Save as Video option saves the selected, displayed, or copied text to a video file, with
the text displayed as it is read out.
To save text as video:
1. Depending on the application you are using, select text or copy it to the clipboard.

2. Click

and then Save as Video.

ClaroRead launches its Save to Video tool:

Note that the Save to Video tool has its own help system. Click Help > Manual (or press
F1) to access it.
3. Select the target device from the Device drop-down list.
As well as setting the output file format, ClaroRead optimises the video for that device’s
display. The Preview area updates accordingly.
Note that ClaroRead will not transfer the video file to a mobile device automatically – you
need to either specify a save folder on your device, or move the file to it after it has been
created.
4. Select a font and background colour for the video.
You can do this using either the Font and Background buttons, or the Appearance menu.
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5. Add a border, if required, from the Appearance menu.
If you are going to view the video on your computer, a border can help you focus on the
text that is being read out.
6. In the Text to Output area, check the text that will be read and edit it if required.
7. Click Create.
The standard Save As window appears.
8. Enter a location and name for the video file, and then click Save.
The Save to Video tool shows a progress bar while it saves your text to the specified
video file. For long passages of text, this can take a significant amount of time.
9. By default, the Save to Video tool plays the video so you can check it, using your default
media player for that file type.
You can change this option from the Options menu.
10. Close the media player and the Save To Video tool.
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ClaroRead Extras
The Extras button provides a handy link to selected other software programs. If you
have any of the following programs installed, they will appear in the list.

ScreenRuler
ScreenRuler places a tinted strip (”ruler”) or a solid line (“underline”) across the screen that
moves with your pointer and helps you to focus on the current line or paragraph. You can
configure the strip's colour as well as tinting the screen outside it. For example, many users
find a pale ruler on a darkened screen helpful.
More about ScreenRuler

ClaroView
ClaroView provides a tinted overlay for your whole screen, which may make it easier to read
than the usual black-on-white text. You can choose colour and intensity to match lighting
conditions, the time of day, or simply your own preference.
There is also a TrueBlack mode, which tints the page background while leaving text (and
other dark colours) unchanged. This is similar to the effect of a physical filter and may work
better for some users.
More about ClaroView

ClaroCapture
ClaroCapture is a study skills tool that lets you capture text and images from different
locations into one "ClaroCapture project". This allows you to gather information in
preparation for writing documents such as essays or reports.
More about ClaroCapture

ClaroIdeas
ClaroIdeas is a mind mapping and idea capture program that helps with research, planning,
outlining, studying and presenting. It helps users and groups to capture their ideas, pictures,
research notes, web page links, audio and video files with more freedom, flexibility and
creativity.
More about ClaroIdeas

Claro AudioNote
Claro AudioNote lets you record lectures and audio notes into Word documents and
PowerPoint presentations, and play back your own recordings with index marks.
More about Claro AudioNote
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Claro BookReader (Netherlands only)
Claro BookReader is a self-contained PDF reader that reads PDFs aloud using high-quality
synthesised speech with synchronised highlighting. You can change background colours to
make your PDFs easier to read, as well as adding your own highlighting and annotations.
Note that BookReader is only available in the Netherlands – for all other countries, use
ClaroPDF instead.
More about Claro BookReader

ClaroPDF
ClaroPDF is a simple cross-platform PDF reader that reads PDFs aloud using high-quality
synthesised speech with synchronised highlighting. You can add highlighting and simple
annotations. PDFs saved using ClaroPDF are fully compatible with Adobe Acrobat and other
popular PDF applications.
More about ClaroPDF

Speaking Calculator
The Claro Speaking Calculator is a simple calculator that speaks each number or operation
as you click its buttons (or use your keyboard), and then speaks the result when you click
Equals (or press Enter). It includes a Repeat button that reads out the previous calculation in
its entirety.
More about Claro Speaking Calculator

Auto Converter (ClaroRead Pro only)
The Auto Converter makes Word, accessible PDF, or plain text versions of documents or
images that you save or copy into a monitored folder.
See Auto Converter.

Batch Audio Converter
The Batch Audio Converter makes audio files from every Word or PDF document in a
specified folder.
See Batch Audio Converter.

Claro Software Website
Sign in to the Claro Software website to download extra software, install more voices, or to
access our online services and apps.
Sign in to the Claro Software website
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Advanced Settings Editor
The Advanced Settings Editor contains additional configuration options including spelling,
homophone, and prediction functions.
See Advanced Settings Editor.

Auto Converter (ClaroRead Pro only)
The Auto Converter makes accessible Word, PDF, or plain text versions of documents or
images that you save or copy into a monitored folder.
Supported input file types include .pdf, .gif, .tif, .jpg, .bmp, .png, .kes, .epub, .docx, .doc, .rtf,
and .s2t

To configure and start the Auto Converter:
1. Run the Auto Converter from either the Extras button on the ClaroRead toolbar, or the
Claro Software folder in your Start menu.
2. In the Auto Converter window, click
Note that you can click

and specify a folder to monitor.

to open the folder and check its current contents.

3. Select the check boxes for the required output file types.
4. Click OK.
The Auto Converter minimises to the Windows System Tray and attempts to convert any
input files that you save or copy to its monitored folder. Once processed, input file names
are suffixed with [ORIG] and output files are suffixed with [PDF], [WORD], or [TEXT].
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Batch Audio Converter
The Batch Audio Converter makes audio files from every document in a specified folder, just
as if you had used ClaroRead to read each document aloud.
Supported input file types include .pdf (accessible only), .docx, .doc, .odt, .rtf, .txt, and .htm.
You must have Microsoft Word 2013 or later installed.

To run the Batch Audio Converter:
1. Run the Batch Audio Converter from either the Extras button on the ClaroRead toolbar,
or the Claro Software folder in your Start menu.
2. Select the folder that you want to convert and click OK.
3. In the Batch Audio Converter window, select the voice that you want to use and the
speed that you want your text to be read.
4. Select the required output format.
5. Click OK.
The Batch Audio Converter attempts to process any documents in the specified folder,
saving its output audio files to the same folder. You may be prompted to confirm certain
steps, for example Word converting PDFs into editable Word documents.
When conversion is complete, a message appears confirming the number of files that
have been converted.
6. Click OK to close the message.
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Scanning Features
ClaroRead’s speech features all speak text that is on your screen, for example in
Microsoft Word or a web browser. However, some text is inaccessible, that is, it
cannot be selected and read out normally – for example, text that is part of an image,
or a section of a web page that cannot be selected, or even on a sheet of paper. For
inaccessible text, you can use ClaroRead’s scanning features.
ClaroRead’s scanning features use the powerful OmniPage Optical Character Recognition
(OCR) technology to take any text, even if it is not encoded as words and characters, and
convert it into standard text that can be used in your documents and read out by ClaroRead.
Click the Scan button on the ClaroRead toolbar to show the available options:

•

Scan from Paper – scans a paper document and converts it to standard text, with the
output sent directly into a Word document or saved to file.

•

Scan from PDF/File – scans inaccessible text in an electronic format, such as a nontextual PDF or an image file, and converts it into standard text. Output can be sent
directly into a Word document or saved to file.

•

Scan from screen – scans text from the screen, even if that text cannot be selected
normally, and sends it to the clipboard as standard text.

ClaroRead Plus and ClaroRead Pro
ClaroRead Plus has a convenient and fast scanning process, with a Preview window that
enables you to set reading order, delete pages that you do not need, and so on. You can
send the output directly into Microsoft Word, or save it to a range of formats including Word,
PDF, and plain text.
ClaroRead Pro has a more powerful scanning process, including an extra Proofing window
for editing the scanned document before you save it. Features include checking spelling and
correcting scanning mistakes, as well as editing, formatting, redacting, and highlighting text.
ClaroRead Pro also includes many more output formats, including ePub and Kindle, as well
as password protection and other advanced options.
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Scanning from Paper
The “Scan from Paper” option uses your scanner to scan a paper document – for example,
pages from a book, a newspaper, or a handout. ClaroRead then uses OCR to convert that
document to usable text before sending it directly into a Word document (where it can be
spoken aloud) or saving it to a file that can be read out or edited later.
To scan a paper document:
1. Get your scanner ready. Switch it on, if necessary, and place your document on its
scanning surface or in its sheet feeder.

2. Click

and then “Scan from Paper”.

3. If you have no scanners set up, for example if this is the first time you have used
ClaroRead to scan a document, the Scanner Setup wizard opens. Follow the instructions
in the wizard to set up your scanner.
See Scanner Setup Wizard.
4. ClaroRead starts its scanning process. Depending on your scanner setup, ClaroRead
either:
•

Scans the document immediately using its own settings, as configured in the
Scanner Setup wizard.

•

Opens a scanning utility. Perform the required steps to complete the scan – for
example, check settings and then click Scan.

•

Prompts for a file to scan (if using “File: Pictures” as your scanner). Select a file and
click Open.

5. When the scan is complete, ClaroRead prompts for additional pages:

Select Yes to repeat the scanning process for the next page, or No to continue.
Note that, depending on your scanner setup, you may already have scanned multiple
pages – if your scanner has an automatic document feeder, for instance. If you have
scanned all the pages that you need, simply click No.
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6. The Preview window appears, showing text flow in your scanned document:

Use the Preview window to set reading order, remove parts of the document that you do
not want to scan, and so on.
See Preview Window.
7. When you have finished adjusting the document, click one of the following buttons:
•

Send to Word – send text from the document directly to the currently open Word
document. Before clicking this button, make sure that you have the correct document
open and that the cursor is positioned at the place that you want to insert text.
If you are not currently working in Word, ClaroRead inserts the scanned text into a
new Word document.
Sending scanned text to Word means that it is ready to be edited or read out by
ClaroRead immediately.

•

Save as PDF – save the scanned document as a Claro PDF file. Specify a file name
and location, and then click Save.
Saving as a PDF gives you an exact copy of the original document, with accessible
text that you can read out using ClaroRead, copy to other applications, and so on.

•

Save As – save the scanned document to a one of several file formats, including
Word, PDF, and plain text. Specify a file type, name, and location, and then click OK.
If you have ClaroRead Pro, the Save to File window includes many more output
formats, including ePub and Kindle. Each file type has its own options, such as
password protection for PDFs.
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Note that, while ClaroRead is configured by default to show the Preview window, the
“Preview scanned image” option may have been turned off. If so, you will be prompted to
save the scanned document to file instead.
If you have ClaroRead Pro and the “Proofread before converting to text” option is enabled,
the Preview window will not show the three buttons described above. Instead, click OK to
proceed to the Proofing window – after you have finished checking and correcting the
document, you will be able to use the Proofing window’s Send to Word, Save as PDF, or
Save As button.
See Proofing Window (ClaroRead Pro only).

Scanning from PDF or File
The “Scan from PDF/File” option takes a file containing inaccessible text, for example a nontextual PDF or an image, and converts it into standard (or accessible) text, saved to a file.
Inaccessible text is text that is not encoded as words and characters. For example, scanned
documents are often saved as inaccessible PDFs, which are pictures of the scanned page
rather than text that you can select, copy, and so on. You will know that a PDF is
inaccessible when you cannot select text using Adobe Acrobat’s Selection tool.
Another example is when you take a photo of a sign or document using your smartphone –
this is a picture of some text rather than text that you can use. ClaroRead cannot read out
inaccessible text, and neither can other programs.
ClaroRead can scan files and use its OCR to make inaccessible text into standard text –
actual words and letters. ClaroRead’s “Scan from PDF/File” feature can handle PDFs and a
wide range of other file formats, including .gif, .tif, .jpg, .bmp, .png, .kes, .epub, .docx, .doc,
.rtf, and .s2t.
You may also find that even accessible PDFs, which can already be read out in ClaroRead,
will read out much better if you scan them and then save them to PDF again. This is
because the ClaroRead scanning process is optimised to produce readable PDF files.
For more details on accessible PDFs, see Making Accessible PDFs.
To scan from a PDF or file:

1. Click

and then “Scan from PDF/File”.

ClaroRead prompts for a PDF or image file to scan.
2. Select a file and click Open.
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3. ClaroRead scans the specified file and opens the Preview window:

As with the “Scan from Paper” option, use the Preview window to set reading order,
remove parts of the document that you do not want to scan, and so on.
See Preview Window.
4. When you have finished adjusting the document, click one of the following buttons:
•

Send to Word – send text from the document directly to the currently open Word
document. Before clicking this button, make sure that you have the correct document
open and that the cursor is positioned at the place that you want to insert text.
If you are not currently working in Word, ClaroRead inserts the scanned text into a
new Word document.
Sending scanned text to Word means that it is ready to be edited or read out by
ClaroRead immediately.

•

Save as PDF – save the scanned document as a Claro PDF file. Specify a file name
and location, and then click Save.
Saving as a PDF gives you an exact copy of the original document, with accessible
text that you can read out using ClaroRead, copy to other applications, and so on.

•

Save As – save the scanned document to a one of several file formats, including
Word, PDF, and plain text. Specify a file type, name, and location, and then click OK.
If you have ClaroRead Pro, the Save to File window includes many more output
formats, including ePub and Kindle. Each file type has its own options, such as
password protection for PDFs.
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Note that, while ClaroRead is configured by default to show the Preview window, the
“Preview scanned image” option may have been turned off. If so, you will be prompted to
save the scanned document to file instead.
If you have ClaroRead Pro and the “Proofread before converting to text” option is enabled,
the Preview window will not show the three buttons described above. Instead, click OK to
proceed to the Proofing window – after you have finished checking and correcting the
document, you will be able to use the Proofing window’s Send to Word, Save as PDF, or
Save As button.
See Proofing Window (ClaroRead Pro only).
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Scanning from Screen
The “Scan from screen” option scans part of your screen, uses OCR to identify any text, and
then saves that text to the Windows clipboard.
This is useful if you can see some text on your screen but you cannot access it – for
example, an inaccessible part of a web page, an application that does not let you copy text,
or text from an image.
To scan text from your screen:
1. Make the text you want to scan as large as possible.
This helps ClaroRead to recognise the text correctly – computer displays typically have a
much lower resolution than a printed page, so it can be more difficult to use OCR with
on-screen text.

2. Click

and then “Scan from screen”.

Your screen freezes and the mouse pointer changes to a crosshair, waiting for you to
select the area that you want to scan.
3. Click the left mouse button and hold it while you drag out a rectangle around the text that
you want to scan.
ClaroRead overlays your screen with a blue rectangle as you select the scanning area:

4. Release the left mouse button.
ClaroRead scans the area you selected and copies any text to the clipboard.
If you have “speak when mouse selects” enabled (in ClaroRead’s Advanced Speech
settings), ClaroRead will also read out the text.
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Alternatively, you can click
that has just been scanned.

to read the contents of the clipboard, that is, the text

If you want to see the text, or read it out with highlighting, simply paste it into Microsoft
Word.

Preview Window
ClaroRead’s Preview window shows you a preview of the scanned document and gives you
options for setting reading order and removing parts of the document that you do not want to
scan.
Reading order is very important when making accessible PDFs. See Making Accessible PDFs.
The Preview window also enables you to choose whether you want to send the scanned
document directly to Word or to save it to file, either as a PDF or to another format.

Note that if the Proofing window is also enabled, the Preview window will not contain Send to
Word, Save as PDF, or Save As buttons. Instead, it will have an OK button that saves
changes and opens the Proofing window.
By default, ClaroRead shows the Preview window as part of the “Scan from Paper” and
“Scan from PDF/File” processes. If you do not want the window to appear, for example if you
always want to save the scanned document as a file, clear the “Preview scanned image”
check box in the Scan Settings.
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Image thumbnail view
An image thumbnail preview appears at the left of the Preview window only if you have more
than one page. This lets you change between pages and delete pages. It also shows the
status of the page.
See Proofing Window (ClaroRead Pro only).

Main Preview area
The main Preview area in the centre of the Preview window shows each page and what will
be scanned (OCR) on each page. These are called Zones. Text zones and images that will
be scanned are marked with boxes and icons:
Text zone to be scanned. The text in a text zone will be OCR'd and available for
reading or editing.
Image to be scanned. Any text in an image zone will not be readable, because it will
not be OCR'd. It will appear exactly like the original document, just as you see it here.
You can edit these Zones to control what is scanned and OCR'd. See Selecting what is
going to be scanned.

Preview toolbar
To the left of the Preview is a toolbar with many commands:
Select zones with the mouse
Delete the selected zone. Select areas that contain scanning errors (marks on the
original paper) and useless text (repeated header and footer content) and click Delete
to stop them appearing in your output.
Create a text zone. Only text in a text zone will be scanned and appear in your output.
Create (identify) an image. Only images in an image zone will be scanned and appear
in your output.
Create (identify) a table.
Removes a part of a zone. Use to create irregular text zones round text that isn't in a
simple rectangle.
Delete all zones on this page. Useful shortcut if you want to redraw them all manually.
Change the reading order of the output file. Useful if you are saving to a PDF. See
Setting the reading order.
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Zoom into the Preview.
Zoom out of the Preview.

detail.

Zoom so that the current page fits entirely into the Preview window. You can
maximise the Preview window to make it bigger, or zoom in to see a section in more
Undo.
Redo.
Flip the image along the vertical axis (so left goes to right and right to left).
Rotate the page anti-clockwise.
Rotate the page clockwise.
Rotate the page 180 degrees. Useful if your scanner has presented the page upside
down and ClaroRead has not managed to reverse it.
Print this whole set of scanned pages. This can be handy if you want to copy pages:
just scan, then print, without having to go through a document format in between.

Setting the reading order
Reading order is very important if you are making accessible PDFs. You can set it by
clicking the Zone Order button, then clicking on each zone (image or block of text) in
the Preview in order. An arrow and a number show the final order.

Deleting pages from an input document
You can remove pages from an input document. For example, you may only want to scan
one chapter from a PDF file.
You do this by selecting pages in the Image Thumbnail view on the left. (The Image
Thumbnail view is only shown if you have more than one page in the input document.) You
can then click the Delete button to remove the selected pages.

Combining documents and adding pages
You can combine pages and documents together. This is useful if you interrupt scanning
half-way through and want to add more pages, or you want to combine some image or PDF
files into one PDF or Word document.
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Open a file or scan a document as usual, then click the Add pages button. Select to scan a
page or add a new file and the new page or file will be added to the current document.

Selecting what is going to be scanned
ClaroRead does its best to make sense of everything on a page, so sometimes it can try to
scan sections that you don't want, like marks on the page from scanning or images you don't
want in the output.
The areas that are going to be scanned are called “zones”. You add and delete and edit
zones using the buttons on the Preview toolbar.

Example of editing zones
ClaroRead has identified a speech bubble as an Image Zone, so it will be contained in the
output document after scanning. We would rather it were a Text Zone, so we could read it
back. We don't mind about losing the image.
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Click on the Image Zone to select it:

Click on Delete Zone to remove the zone. It will no longer appear in the output document:
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Click on Create a Text Zone, then select the area containing the text you want to scan and
OCR. This text ("Get help now!") will now appear as readable text in the output document:

68

Proofing Window (ClaroRead Pro only)
The Proofing window is only available in ClaroRead Pro. It contains options for editing the
scanned document before you save it. You can check spelling, edit text (both content and
formatting), redact or highlight text, and so on.
The Proofing window is not enabled by default. To enable it, select the “Proofread before
converting to text” check box in the Scan Settings.
If enabled, the Proofing window appears after the Preview window, accompanied by the
OCR Proofreader tool:

Use the Proofing window to correct any OCR errors in your scanned document, and then
click one of the buttons at the top right of the window to send it to Word, save it as a PDF, or
save it as another file type.

OCR Proofreader
You can use the OCR Proofreader to step through any errors flagged in the document, for
example characters with low legibility and words that ClaroRead is not sure about. The panel
at the top of the window shows the exact scanned copy, with the current match and a
number of alternative suggestions shown below it.
You can close the OCR Proofreader at any time, and restart it from the Proofing window’s
Tools menu.
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Text Editor
In the centre of the Proofing window is the Text Editor. This shows any detected errors with
a red underline, just like Microsoft Word. You can use this to correct spelling and recognition
mistakes in your document. It always shows the page as in the format of the original so you
can easily match up the text to the original document, but your Keep Original Format or
Simplify Format setting will be preserved in the final output.

Verifier
Above the Text Editor is the Verifier. This shows the actual original image you have scanned
for where your cursor is in the Text Editor. This lets you check the result of scanning (in the
Text Editor pane) against the original image (in the Verifier pane).
In the Proofing stage you are working with what ClaroRead thinks is the underlying page
content. If you are scanning from a paper or an image file then this may be inaccurate – for
example, you may have some damaged area of the paper that has confused ClaroRead. It
might be hard to correct the text in the Proofing view if you don't have sight of the original
image.
The Verifier provides you with a view of the underlying image or paper that ClaroRead is
processing. This lets you check the text you have got (in the Text Editor) against what was
on the original page (in the Verifier). Just turn it on in the View menu (Verifier submenu,
select Show) and click anywhere in the Text Editor text. The Verifier then shows the original
page at that point so you can check they match. You can zoom this original view in and out
to check smaller details with the Zoom submenu.
By default the Verifier is shown at the top of the Text Editor. To make it float (follow the
cursor) select Dynamic. To change what is shown in the floating Verifier select Line, Three
words or One word from the Verifier submenu.

Image Thumbnail View
The Image Thumbnail View, at the left of the Proofing window, shows all the pages in the
document to be proofed. You can click on a page to select it. The Image Thumbnail View is
not shown if your document only has one page. It also appears in the Preview window.
Icons at the bottom of each thumbnail indicate the status of that page:
•
•

The current selected page.
A page that has not yet been OCR'd. You see this on all the pages in the Preview
window.

•

A page that has been recognised (OCR'd) but not otherwise changed by you.

•

A page that has been proofed by this dialog.

•

A page you've made changes to.

•

A page you have proofread and made changes to.
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You can delete a page from the document by selecting it and pressing the Delete key (or
right-clicking and selecting Clear from the popup context menu).

Status bar, Ruler and Toolbars
You can turn these on and off in the View menu. By default they are all off.
•

The Formatting toolbar has Style, Font, Alignment, Bullets and Show Paragraph buttons,
just like Word or WordPad. These can be used to edit the text in the proofing view so you
can get the appearance of your final output just right.

•

The Mark text toolbar has Highlight and Strikethrough buttons, which you can use to
mark up your document. It also has a Redacting tool you can use to mark sections of text
that you want to appear with black rectangles overlying the text (so you can see where
the text was). Highlight with the Redacting tool and click the Redact Document button,
the last button on the toolbar, to redact this marked text.

•

The Ruler gives you the dimensions of the current page or text area. You can change
among inches, centimetres, points and picas in the View menu with the Measurement
units submenu.

•

The Status Bar shows you the position of the cursor and the language that ClaroRead
believes is the writing of the text. This is useful because if it does not match the actual
language of the text then the text will be incorrectly recognised and spell checked. Use
the Set Language... option in the Tools menu to change the selected language.

Views
You can view the current page in one of three ways, selected from the Text Editor views
submenu of the View menu.
•

True page means the page will be displayed on the screen as it was laid out on the
original paper. This is useful to identify page reading order and to make sense of the
structure of a page. This is the default.

•

Formatted text extracts the text content but keeps font, colour and font size so it is like
editing a Word document. This may be simpler. It better represents the output of the
page if you are creating a re-flowing PDF file.

•

Plain text presents only the text content. This is best if you want to work with the text
content only, for example if you will be converting the text to audio.
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Character Map
You may have non-standard characters for your current language in your text. For example,
in a maths textbook you will often have Greek characters like sigma (Σ) or pi (Π). This may
confuse ClaroRead (if it is scanning English it will try to fit every letter into an English
character, for example) and produce wrong results. You can solve this and improve
scanning by adding these non-standard characters to the set of recognised characters by
using the Character Map. Make the character set you want to use visible by selecting it in
View, Character Map, Character sets. Then click on the characters to add to the recognised
set of characters for your scanning. These will be used in subsequent scans and
remembered, so you only have to do this once. The characters you select will be added to
the document, so simply delete them.
You can also select "Edit permitted characters" in the Tools menu and add characters you
want to be recognised by hand.

Character Training
You may want to correct some sections of text which have been incorrectly identified, like
Greek letters used in maths or scanned text from paper. These characters or sections will be
highlighted in yellow in the Text Editor. Click on the character to place the cursor on it. Then
select "Train character recognition" from the Tools menu. The "Train Character" window will
open, showing the original text/image and what ClaroRead thinks it is. Enter the correct
character or characters in the "Correct" box and click Train to correct the scanned text.
These corrections will be remembered for next time.
You can review the character training by selecting "Edit character training" from the Tools
menu. Select and delete any training you do not want to be saved, or right-click and edit it.
You may need to train several characters, for example where ClaroRead has incorrectly
identified a single letter as several letters. Simply select all the affected letters before you
click "Train character recognition" and the training and correction will be applied to all the
letters.

Format
You can edit the text in the Proofing dialog, and the Format menu lets you change font,
paragraph alignment, style and other text attributes. This is useful if you are planning to save
the document as a PDF file and want to amend how it will look, for example using a more
readable font to replace what has been used in the original scanned document. However, if
you are sending the document to Word to read or edit you will probably find this easier to do
there.
Note that if you are saving as PDF the original position and size of text areas will be
retained. So if you make text bigger it will start to overlap and bits will be missing. If you want
to edit the document you are scanning we suggest sending it to Microsoft Word to edit and
correct it, rather than using the Proofing dialogue.
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Proofreading
Just like Microsoft Word, the Proofing dialog will take you through all the identified spelling or
OCR errors in the current document. This starts automatically when you open the Proofread
dialog. You can also select Proofread from the Tools menu and the Proofreading process
will re-start. You will be shown the next spelling or OCR problem and can decide whether to
correct or add it, just like the spell check in Word. Changes will be remembered for future
scanning sessions. When you have finished with a page or document click the Page Ready
or Document Ready button and no more errors on this page will be identified. When there
are no more errors in the document then the Proofread option will grey out.
You can also press F4 or select "Find next suspect" to jump straight to the next identified
error in the page without opening the Proofreading process. If you want to start the Proofing
process again, having previously marked pages or the whole document as done, then select
Recheck Page from the Tools menu.
You can review the spellings you have added to the Proofing dictionary by selecting "Edit
user dictionary" from the Tools menu. This will show a list of the words that will be
recognised as correct spellings. You can delete any words that should not be there and
should be marked as incorrectly-spelled.

Language
It is vital that ClaroRead has the language of the document correct, or it will not recognise
(OCR) correctly and it will identify all the words as incorrectly-spelled. The Status Bar will
show the language of the current text (where the cursor is positioned). You can select text
and identify the correct language by selecting the language from the Tools menu.
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Making Accessible PDFs
PDF files are very common but can be very hard to use. ClaroRead Plus and Pro give you
ways to make them usable and accessible.
This is a guide to making accessible PDF files with ClaroRead. For an in-depth discussion of
PDF accessibility, see the PDFs and Accessibility guide on our website.

Quick approach
This is suitable for individual users who want to make PDF files for their own use from
scanning books or documents, or who have a PDF file that they need to read but is
inaccessible (does not read at all or does not read very well). It works for both ClaroRead
Plus and ClaroRead Pro.
1. Scan using ClaroRead Plus or Pro.
2. Click Save As and save as a "Claro PDF" file. This will automatically be made accessible
by ClaroRead.
3. Read back the PDF file by opening it with Adobe Reader and reading it with ClaroRead.
4. Keep the original PDF file for future reference – much quicker than scanning it again.
You can always re-scan the PDF file with ClaroRead Plus or Pro if you want to alter its
accessibility or format or convert it into Microsoft Word to edit it.
The ClaroRead scanning process is optimised to produce an accessible PDF file, so even if
you can read a PDF okay but you have some problems (like jumping around the page), it
may work better if you scan it and save as a PDF file again.

Advanced approach
This is suitable for someone who wants to create a canonical, high-quality accessible PDF
file, maybe for redistribution or long-term storage. It works best with ClaroRead Pro,
although you can still correct the reading order in the Preview window with ClaroRead Plus.
1. Decide on your target audience. The basic split is "screenreader users and people with
very low vision" versus "mouse users and people with reading problems" Or "blind"
versus "dyslexic" to simplify.
See the PDFs and Accessibility guide on our website for a discussion on the differences.
2. Decide how much work you want to do on the document content. Are you essentially
making the existing file accessible (for a dyslexic user, for example) or are you doing
more work to re-purpose the content more fundamentally (stripping out extraneous
content for screenreader users, for example).
3. ClaroRead settings:
a. Turn on Preview and (optionally) Proofing in the Scan Settings.
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b. Set the correct OCR language in the Scan Settings.
c. For "blind" users consider turning off images and simplifying format. For "dyslexic"
users turn on images and use the original format.
4. Scan in from paper or file using ClaroRead.
ClaroRead will attempt to determine the correct reading order in the document, and
remove unwanted images.
5. Correct reading order in the Preview window. See Preview Window.
a. Delete superfluous content for "blind" users such as headers and footers.
b. Remove page numbers and other non-reading content for "dyslexic" users.
ClaroRead now performs OCR, converting all inaccessible content into accessible text.
6. If you have ClaroRead Pro, correct text content in the Proofing window. See Proofing
Window (ClaroRead Pro only).
a. Correct spellings and incorrect OCR results.
b. Add full stops at the end of titles and other lines without punctuation.
7. Output to your desired format:
a. If you need to make major changes to the document then click Send to Word. Word is
a far better editing and word processing tool than ClaroRead. If you have Word 2010
or later you can then save the Word document as a PDF file directly. Make sure it is
tagged (Save As, PDF, Options, check "Document structure tags for accessibility").
You can also add contents and headings. This may be suitable for "blind" users.
b. If you're okay with the content as it stands (correct reading order, no spelling
mistakes) then click Save as. Make sure it is at least PDF version 1.4. Do not optimize
for size. Do not show background image layers.
i.

If you want the output to look exactly like the original then save it as a Claro PDF.
This is the only way to make sure the output looks exactly like the original
scanned PDF or book, which is very helpful for "dyslexic" users.

ii. If you want the output to be able to be reflowed and zoomed and don't mind about
it looking identical to the original then save it as "PDF - Edited" or even text. This
is useful for "blind" users.
For PDF output, accessibility information, or “tags”, are added here.
8. Read back with ClaroRead (Adobe Reader, Microsoft Word, or use Save to Audio or
Video) or distribute the accessible file to others. Keep the file safe so you don't have to
go through the preparation process again.
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ClaroRead Settings
Click the Settings button to open ClaroRead’s Settings window. This button is
always present on the ClaroRead toolbar.
The Settings window has five tabs:

•

Speech tab – controls how ClaroRead reads out text, including which voice to use and
how quickly it speaks. You can also choose which speech features are available.

•

View tab – controls how the ClaroRead toolbar looks and behaves, as well as which
buttons appear on it.

•

Prediction tab – controls the behaviour of ClaroRead’s word prediction.

•

Check tab – settings for the Check window, which is used by ClaroRead’s spelling and
homophone checkers, as well as the dictionary tooltip.

•

Scan tab – settings for ClaroRead’s scanning process.

Language list
Depending on your system language, you may have a Language drop-down list at the
bottom of the Settings window. Select a language for ClaroRead to use when speaking text,
checking spelling, and so on.
See Language Selection.

About button
The About button, at the bottom left of the Settings window, enables you to see the exact
version of ClaroRead. You can also use it to deactivate your ClaroRead license.
See About ClaroRead.
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Advanced Settings Editor
ClaroRead’s Advanced Settings Editor contains additional configuration options including
word lists for the spelling, homophone, and word prediction features. It can be accessed
through the Extras button on the ClaroRead toolbar.
See Advanced Settings Editor.

Speech Settings
The Speech tab controls how ClaroRead sounds when it is reading out text. It also contains
check boxes that control basic speech behaviour and buttons to access further features and
settings.

Voice
The Voice drop-down list contains all the voices available on your system:

ClaroRead is supplied with a range of high-quality voices for each supported language, but it
will also work with other SAPI5 voices installed on your computer. This includes Microsoft
system voices such as David and Hazel.
ClaroRead uses the selected voice for all speech, unless your system is set up for multiple
languages.
You can select the “Get more Claro voices” option, at the bottom of the list, to install more
Claro Software voices.
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Speed and Volume
The Speed and Volume sliders control the speed and volume of the selected voice. Slide
them left (slower/quieter) or right (faster/louder).

Test
Click the Test button to speak a sample of text using your selected voice, speed,
and volume. Note that it can take a few seconds to load a new voice.

Pronounce
Click the Pronounce button to open ClaroRead’s pronunciation list for the current
voice. If the selected voice does not pronounce something correctly, for example
a name or a place, you can add a correction for it.
See Adding a Word Pronunciation.

Save as Audio File
Click the Save as Audio File button to save the selected text as an audio file.
This is the same as the Save as Audio option under the ClaroRead toolbar’s Save
button.
See Saving Text as Audio.

Advanced Speech
Click the Advanced Speech button to open the Advanced Speech settings
window, which contains settings for auto-speak (that is, what ClaroRead speaks
automatically while you are using your computer) and text highlighting.
See Advanced Speech Settings.

Pause between words

Select this check box to make ClaroRead deliberately separate each word when speaking
text. This makes hearing different separate words easier.
If the check box is not selected, speech will flow naturally, and will take account of
punctuation, certain abbreviations and other text details.
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Stop after sentence

Select this check box to make ClaroRead read only one sentence at a time when you use
“click and play”, that is, when you click the Play button while working in applications such as
Microsoft Word and Adobe Acrobat.
To read the next sentence, you will need to click Play again.

Speak word on Ctrl + hover

Select this check box to enable the “speak on Ctrl+hover” speech feature – when you hold
down the Ctrl key and hover the mouse pointer over any word on your screen, ClaroRead
will read that word aloud.
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Adding a Word Pronunciation
There are times when a text-to-speech voice does not pronounce something quite as you
like, for example names of people or places. To correct how a word or phrase is
pronounced, you can add it to ClaroRead’s pronunciation list

To open the pronunciation list for the current voice, click
tab.

on the Speech settings

To add an entry to the list, type the word or phrase that is being mispronounced in the “Word
to replace” field, and then type how you think it should sound in the “New pronunciation”
field.
You can click the Test buttons to see how the current voice pronounces your entries – you
may need several attempts before you are happy with the new pronunciation.
When you are happy with the pronunciation, click Add/Replace to add it to the pronunciation
list.
Note that each voice has its own way of pronouncing text. Selecting a voice that is close to
your own voice or region will result in better pronunciation. ClaroRead maintains separate
pronunciation lists for each language – for example, a Swedish voice will need a very
different list to an English voice.

Match whole words only
If you want to change the pronunciation of a word but not affect other words that start with
the same letters, select the “Match whole words only” check box.
For example, if your name is “Alis” and you want it to be pronounced as “Allee” but you do
not want “Alison” to become “Allee-on”, select this check box before you click Add/Replace.
Words with this check box selected are shown with a * in the pronunciation list.

80

Advanced Speech Settings
The Advanced Speech settings control the amount and type of speech from ClaroRead, as
well as how text is highlighted in applications such as Microsoft Word and Adobe Acrobat.

To open the Advanced Speech settings, click

on the Speech settings tab.

The Advanced Speech settings are divided into two sections:
•

Auto-speak – these settings control some of ClaroRead’s speech features.

•

Highlight – these settings control how ClaroRead highlights text.

When you have finished editing Advanced Speech settings, you can either click Back to
return to the main Settings window, or click OK to close both Settings windows.
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Auto-speak Settings
The check boxes on the left side of the Advanced Speech settings control some of
ClaroRead’s speech features:

Speak when mouse selects
Select this check box to enable the “speak when mouse selects” speech feature –
ClaroRead will read out any text you select with your mouse. This works in most applications
and is often the most convenient way to speak text.

Speak Under Mouse
Select these check boxes to enable the “speak under mouse” speech feature – ClaroRead
will read out any text you hover your mouse pointer over, including tooltips, button names,
and menu items.
By default, the Some check box is selected – “speak under mouse” is enabled for a small
selection of applications including Internet Explorer and Mozilla Firefox.
Select the All check box to enable “speak under mouse” for all applications, which makes
almost all on-screen text accessible. Note that this can result in a lot of speech, which may
be confusing or distracting.

Characters / Words / Sentences
Select these check boxes to enable the “echo text as you type” speech feature for
characters, words, or sentences. When selected, ClaroRead will:
•

Speak back each character (letter or key) after it is typed.

•

Speak back each word after it is typed.

•

Speak back each sentence after it is typed.

This is very useful for checking spelling and grammar during text creation and for reviewing
sentences as they are created.
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Cursor moves
Select this check box to enable the “speak when the cursor moves” speech feature –
ClaroRead will read out characters, words, lines, or paragraphs as you press the arrow keys
to move through text:
•

Pressing Right or Left moves the cursor to the next or previous character and
ClaroRead reads out that character.

•

Pressing Ctrl+Right or Ctrl+Left moves the cursor to the next or previous word and
ClaroRead reads out that word.

•

Pressing Down or Up moves the cursor to the next or previous line and ClaroRead
reads out that entire line.

•

Pressing Ctrl+Down or Ctrl+Up moves the cursor to the next or previous paragraph and
ClaroRead reads out that whole paragraph.

You can use these commands repeatedly, for example pressing the Down arrow repeatedly
to read through a document.
You can configure ClaroRead to speak phonetic letter sounds rather than characters when
you press the Right and Left arrow keys. See Letter sounds.

Echo Dragon voice input
Select this check box to enable the “echo dictated text” speech feature. If you use Nuance’s
Dragon speech recognition software, ClaroRead echoes back each word, phrase, or
command that Dragon recognises. This gives you confidence that Dragon has correctly
recognised what you said, or draws your attention to any misrecognitions.
See Echoing Dragon Voice Input.

Letter sounds
Select this check box to make ClaroRead speak phonemes, that is, phonetic letter sounds,
for each character you type instead of its letter name. For example, when you type “a”,
ClaroRead will say “ah” instead of “ay”. Depending on your language, you may be able to
select male or female phonemes.
This check box is only available if the Characters check box is selected. Note that phonemes
are only available for certain languages, and sometimes only in a single gender.
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Highlight Settings
The option buttons and check boxes on the right side of the Advanced Speech settings
control how ClaroRead highlights text:

ClaroRead highlights text when you use “click and play”, that is, when you click Play while
working in applications such as Microsoft Word, Adobe Acrobat, and Internet Explorer.
ClaroRead’s voice is synchronised with the highlight, giving you greater assistance in
following the text.

None
Select this option to disable highlighting – as ClaroRead speaks text, the words it speaks will
not be highlighted.
All the other highlight settings will be greyed out.

Word
Select this option to highlight only the word that is being spoken aloud:

Word trail
Select this option to highlight words as they are spoken, leaving the previously spoken words
highlighted. ClaroRead gradually highlights whole sentences, word by word:
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Some users find the Word highlight option distracting, with a flickering effect as individual
words are highlighted. The Word trail option reduces this effect.

Sentence
Select this option to highlight the entire sentence that is being read out:

This is the default setting.

Paragraph
Select this option to highlight the entire paragraph that is being read out:

Foreground
Click this button to select the foreground colour used to highlight text as it is read out:

The text itself will be changed to the selected colour as it is read out.
If none of the standard colours is suitable, click “Select another colour” to select from all
available system colours.
The “Text” marker, in between the Foreground and Background buttons, gives you a preview
of the selected colours.
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Background
This button is only available if the “No background” check box is not selected.
Click this button to select the background colour used to highlight text as it is read out:

A coloured background will be applied to text as it is read out.
The “Text” marker, in between the Foreground and Background buttons, gives you a preview
of the selected colours.

No background
Select this check box to disable background highlighting. The Background button will be
greyed out.

Focus sentence
Select this check box to grey out the rest of your document while text is being spoken aloud:

This option helps you to focus on the text that is being read out. It can be used with the
Word, Word trail, Sentence, or Paragraph highlight options.
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View Settings
The View tab controls how the ClaroRead toolbar looks and behaves, as well as which
buttons appear on it.

Buttons
The right side of the View tab controls the buttons that are shown on the ClaroRead toolbar:
•

To add a button to the toolbar, click it to make it “pushed down”.

•

To remove a button from the toolbar, click it so that it appears “raised”.

In the above screenshot, for example, the Play, Check, and Help buttons will be shown on
the toolbar, but the Dictate, Font, and Predict buttons will be hidden.
Note that the Font button also controls the Spacing button – they can only be shown (or
hidden) as a pair.

Toolbar
The left side of the View tab controls how the ClaroRead toolbar looks and behaves.

Small / Medium / Large
Select an option to set the size of the toolbar.

Show captions
Clear this check box to remove the text below each button. Removing captions makes the
toolbar more compact, but harder to use for beginners.
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Lock toolbar to active window
Select this check box to lock the toolbar to the currently active window. The toolbar will move
automatically as you switch between different applications, always locked to the top right of
the active application's window.
See Moving, Docking, and Hiding the ClaroRead Toolbar.

Skin options
The option buttons at the bottom of the Toolbar section enable you to choose between three
display styles or skins:
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Prediction Settings
The Prediction tab controls ClaroRead’s word prediction. You can enable or disable word
prediction, select a dictionary, and customise word prediction behaviour to suit the way you
work.

The Prediction tab is divided into three sections:
•

Prediction – these settings control the word prediction style and dictionary.

•

Learn Prediction – these settings control how ClaroRead learns from you as you use
word prediction.

•

Prediction List – these settings control how and when predicted words are displayed.

Use prediction

This check box controls whether word prediction is on or off, and corresponds to the status
of the Prediction button on the ClaroRead toolbar.
If this check box is not selected, all options on the Prediction tab are disabled.
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Prediction Style and Dictionary
These settings, at the top left of the Prediction tab, control the word prediction style and
dictionary:

Prediction style
Select a prediction style from the list. There are four prediction styles to choose from:
•

Completion (c > cat)
This is a conventional word prediction style, which predicts words based on exactly what
you type.
For example, if you type the letter “c”, words like cat and celery might appear in the
Prediction List.

•

Phonetic (k > cat)
This is the default style, and predicts words based on how they sound rather than how
they are spelled.
For example, if you type the letter “k”, words that might appear include cat, competition,
and cow, all of which start with a “k” sound, despite being spelled with a “c”.
This style is good for people who can spell phonetically but are not good with irregular
spellings.

•

First and Contains (gdt > graduate)
This style matches the first letter you type, and then the ones after it in order, anywhere
in the word.
For example, if you type the letters “gdt”, words that might appear include graduate,
grandfather, and goodnight.
This style is good for people who usually get the first letter right but are not sure what
comes afterwards, although they can usually guess or remember some more letters.
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•

Contains Anywhere (ptg > sporting)
This style matches the letters you type anywhere in a word, in any order.
For example, if you type the letters “ptg”, words that might appear include sporting,
copyright, stopping, and photographs.
This style is especially helpful for people who really struggle with spelling, bringing up the
most suggestions and the widest range of matches. However, as it brings up so many
suggestions, it is best used with a small prediction dictionary.

Note that you can also change prediction style from the Prediction List’s right mouse button
menu.

Prediction dictionary
Select a prediction dictionary from the list. The dictionaries available depend on the
language that you are using, but may include:
•

Basic dictionary
This is the standard dictionary for each language, containing a large number of words.

•

Simplified dictionaries
These contain only the most common words, and are intended for use instead of the
basic dictionary. They can be used with the Contains Anywhere prediction style, for
example, to narrow down the prediction range.
For example, ClaroRead includes 2000-word and 5000-word English dictionaries.

•

Subject-specific dictionaries
These contain words specific to a particular subject, and are useful if you are normally
quite good at spelling but are writing something on a subject that has a specialised
vocabulary with complicated words.
For example, ClaroRead’s subject-specific English dictionaries include Archaeology,
Biology, and Nursing. The Biology dictionary includes words and phrases such as
amoeba, DNA sequencing, and ventricle.

You can edit ClaroRead’s prediction dictionaries, or even create new dictionaries, using the
Advanced Settings Editor’s Training Prediction tab. For example, you could create a new
dictionary containing words specific to your industry.
See Advanced Settings Editor.
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Include basic dictionary
Select this check box to include the basic dictionary in addition to the selected prediction
dictionary.
Words from the selected prediction dictionary will appear nearer the top of the Prediction
List. For example, if you select the Biology dictionary but choose to include the basic
dictionary as well, biology-related words will tend to appear before standard words.

Show ignored words
Select this check box to keep showing "ignored" words within the Prediction List.
For example, consider a scenario where you have typed “ca” and the Prediction List includes
cathode, cattle, and catastrophe. What happens when you type the next letter depends on
whether you have this setting enabled:
•

“Show ignored words” deselected
All previously displayed words are ignored, as you have already rejected them. The
Prediction List will no longer include the above words, even if you type “t” as the next
letter.

•

“Show ignored words” selected
Previously displayed words remain available, as long as they still apply for the letters you
have typed. If you type “t” as the next letter, all the above words will still be displayed.

Predict next word
Deselect this check box to disable “next word” prediction:
•

“Predict next word” selected
ClaroRead suggests the next word when you press the spacebar or select a word from
the Prediction List.

•

“Predict next word” deselected
The Prediction List will not be displayed until you have started typing the next word.
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Learn Prediction Settings
These settings, at the bottom left of the Prediction tab, control how ClaroRead adapts the
selected prediction dictionary, that is, how it learns from you as you use word prediction:

In addition to these settings, the Advanced Settings Editor’s Training Prediction tab enables
you to train ClaroRead’s word prediction using your own Microsoft Word documents.
See Advanced Settings Editor.

Automatically add new words
Automatically adds new words to the prediction dictionary based on the words that you type.
If this setting is enabled, we recommend that you also enable “Spell check before adding
new words”.

Spell check before adding new words
Checks the spelling of words before adding them to the prediction dictionary.
This prevents typing errors being added to the dictionary.

Learn word order
When you select a “next word” prediction, ClaroRead remembers your selection and words
you select often will move up the Prediction List.

Sort frequency
Every time you finish a word, ClaroRead increases the likelihood that it will be shown higher
in the Prediction List next time.

Save dictionary when exiting
If enabled, updates to the prediction dictionary will be saved when you close ClaroRead.
This is disabled by default, so you do not accidentally add words you do not want into the
dictionary.
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Prediction List Settings
These settings, at the right side of the Prediction tab, control how and when predicted words
are displayed:

Show pictures
Where available, show pictures in the Prediction List to help you choose words quickly.

Window follows cursor
Rather than the Prediction List appearing at a fixed position on your screen, it will appear
just below your cursor, in any application that you use.
You can also change this setting from the Prediction List’s right mouse button menu.

List words
Select whether you want the words displayed in the Prediction List to be ordered
alphabetically or in order of likelihood.
Note that only the currently displayed words will be sorted alphabetically – the overall
Prediction List remains ordered by likelihood.

Predict after letters
Sets the number of letters you must type before ClaroRead shows the Prediction List.
Increasing this value reduces the activity of the Prediction List and makes it less disruptive.
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Prediction entries
Sets the number of words that are shown in the Prediction List.
While increasing this value makes it more likely that you will see the word you want, it can
make the Prediction List more confusing.

Minimum word length
Sets how long a word must be before it appears in the Prediction List.
If you can usually spell common short words like and, the, and are, but have problems with
longer words, increase this value so that the Prediction List only contains longer, more
difficult words.

Font, Background, and Foreground buttons
Set the font for the Prediction List (including its style and size), as well as its background and
foreground colours.
You may want to use large fonts in the Prediction List so that you can select words more
easily, or change its background colour so that it stands out from your applications.
The area next to the Font, Background, and Foreground buttons shows a preview of how the
Prediction List will look.
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Check Settings
The Check tab contains settings for the Check window (which is used by ClaroRead’s
spelling and homophone checkers) and dictionary tooltip.

In addition to the settings on the Check tab, you can customise ClaroRead’s list of spelling
corrections using the Advanced Settings Editor’s Spelling tab. For example, if you commonly
misspell a particular word, you can add it to the list so that it appears as a suggestion in
ClaroRead's Check window.
See Advanced Settings Editor.

Check Window Settings
The check boxes on the left side of the Check tab control what is shown in the Check
window. They are all enabled by default – deselect a check box to disable the corresponding
feature. This section also includes the Homophones Settings button.

Show spell checker
Controls whether the Spelling tab is shown.

Show meanings
Controls whether the Meanings tab is shown.

Show part of speech
Controls whether parts of speech (that is, whether a word is a verb, noun, adjective, etc.) are
shown in the Meanings tab.
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Show syllabification
Controls whether the syllabification of words is shown at the bottom of the Check window.

Show pictures
Controls whether pictures are shown.

Show phonetics
Controls dynamic phonetic suggestions. These are advanced suggestions based on letter
sounds, like "bizarre" for "bzr".

Homophone Settings button
Opens ClaroRead’s homophone settings.
See Homophones Settings.

Dictionary Tooltip Settings
The check boxes on the right side of the Check tab control the dictionary tooltip’s behaviour.

Use dictionary tooltip
Deselect this check box to turn off dictionary tooltips.

Tooltip follows cursor
By default, the dictionary tooltip stays in one place. You can move it where you want on your
screen, so you know where to look when you need it.
If you prefer the tooltip to move with your cursor, select this check box.

Translate phrase (online)
This check box is only shown if your ClaroRead system has second languages defined.
If selected, ClaroRead will translate any phrase or sentence that you select with the mouse
and display the translation in the tooltip window. You must have an internet connection to
use this feature.
See Tooltip Translations.
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Homophones Settings
The Homophones settings enables you to ignore certain homophones, or disable the Check
window’s Homophones tab entirely.
To open the Homophones settings, click Homophone Settings on the Check settings tab.

When you have finished editing homophones settings, you can either click Back to return to
the main Settings window, or click OK to close both Settings windows.

Exclude list
This list contains all the homophones that will be identified by ClaroRead. To ignore a
homophone, for example because you rarely get it wrong, select its check box. The word will
no longer appear as a homophone.
Note that you can edit ClaroRead’s master homophones list in the Advanced Settings
Editor’s Homophones tab. You can add new alternatives or even whole new homophone
pairs (or triplets, etc.).
See Advanced Settings Editor.

Show homophones
Deselect this check box to disable the Check window’s Homophones tab. The Homophones
tab will not be shown in the Check window, even when you run a homophone check. While
homophones that are obviously being used incorrectly will still be shown in the Spelling tab,
any other homophones will not be highlighted.
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Scan Settings
The Scan tab controls ClaroRead’s scanning process. You can control formatting, scanning
language, and whether to use the Preview and Proofing windows. You can also set up new
scanners using the Scanner Setup wizard.

Format
Select whether you want to keep a scanned document’s original format, or simplify it into a
single text column.
You can also choose whether to include images from the original document or discard them.

Language for scanning
Select a language to use for OCR. ClaroRead tries to recognise text in that language.
For example, if you are going to scan a document in French, select French. Otherwise,
ClaroRead will not know that it is looking for French words and phrases.

Preview scanned image
Deselect this check box to prevent the Preview window appearing after you have scanned a
paper document or a file.
The Preview window shows you a preview of the scanned document and gives you options
for setting reading order and removing parts of the document that you do not want to scan. It
also enables you to choose whether you want to send the scanned document directly to
Word or to save it to file, either as a PDF or to another format.
See Preview Window.
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Proofread before converting to text (ClaroRead Pro only)
If you have ClaroRead Pro, select this check box to show the Proofing window after you
have scanned a paper document or file.
The Proofing window appears after the Preview window, and enables you to edit the
scanned document before you save it. You can check and correct spelling, edit text (both
content and formatting), redact or highlight text, and so on.
See Proofing Window (ClaroRead Pro only).

View result
Select this check box to automatically open output files after scanning. Files will open in their
default applications, for example PDFs will open in Adobe Acrobat.

Run Scanner Setup Wizard button
Click this button to run the Scanner Setup wizard, which configures ClaroRead to connect to
your scanner.
Follow the instructions in the wizard to select the scanner that you want to use with
ClaroRead’s “Scan from Paper” feature, or to set up additional scanners.
See Scanner Setup Wizard.

Reset button
Click this button to reset ClaroRead’s scanner configuration. Any scanners you have set up
using the Scanner Setup wizard are deleted immediately.
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Scanner Setup Wizard
Before you can use a scanner with ClaroRead, you need to set it up using the Scanner
Setup wizard. The wizard runs automatically if you click “Scan from Paper” and have no
scanners set up. Otherwise, you can run it from ClaroRead’s Scan settings.
The first page of the Scanner Setup wizard shows the currently selected scanner and
prompts you to download the latest scanner database from Nuance:

ClaroRead uses its own scanner database, so select No and then click Next.
The second page of the wizard prompts you to choose an action. If you have no scanners
set up, the only option is to select and test a new scanner:

Select an option and click Next.
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If you have no scanners set up, a Select Scanner dialog box appears, prompting you to
select from the list of available scanners:

The list contains all scanners and digital cameras that have been set up on your computer.
Generally, if there are multiple entries for a particular device, select the TWAIN version.
The list also contains a “File: Pictures” entry, which enables you to use the “Scan from
Paper” option to process scanned image files rather than attempt to control your scanner
directly – use this option if you have a shared scanner that scans to a network folder, for
instance.
Select a scanner or digital camera (or the “File: Pictures” option) and click OK.
The next page of the wizard lists the scanners that are set up for use with ClaroRead:

If you are setting up your first scanner, it will be shown with a “+” icon, indicating that the
wizard will be adding it to the list. Click Next.
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The next page of the wizard prompts you to select a mode and specify whether to perform
tests:

We recommend that you select Normal Mode. This will work with most scanners and bypass
your scanner’s normal interface, if possible, making scanning quicker and simpler.
If you cannot get a scanner working under Normal Mode, try again using Safe Mode. Under
Safe Mode, ClaroRead will use your scanner’s normal interface.
We recommend that you select the Perform Tests check box when using a scanner with
ClaroRead for the first time. The wizard will then test the scanner’s connection and scanning
abilities.
After you have selected a mode and chosen whether or not to perform tests, click Next.
Follow the instructions in the rest of the wizard to finish configuring and testing your scanner.
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Language Selection
ClaroRead uses the same language as Windows, that is, its button names and other onscreen text are shown in your Windows system language.
Depending on your system language, you may have a Language drop-down list at the
bottom of the Settings window:

The list contains your system language (in this case, Swedish), as well as any second
languages that are defined for it (in this case, UK English).
ClaroRead will use the selected language for speaking text, checking spelling, and so on.
You can specify different settings for each language in the list. For example, you can set
Vocalizer Alva as the voice for Swedish, speaking quickly, while you use Vocalizer Daniel for
English, set to speak slowly and loudly.

Tooltip Translations
If you select a second language from the Language drop-down list (that is, a language other
than your system language), ClaroRead’s dictionary tooltip will automatically translate
selected words and phrases from your second language into your system language.
See Tooltip Translations.
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Configuring Languages
The Language drop-down list contains a preconfigured set of second languages for your
system language. Some system languages have several languages available, while others
have none.
If your system language does not have any second languages defined, the Language dropdown list will not appear by default. To make it appear, you can add additional languages
using ClaroRead’s Language utility. This is an executable, Language.exe, that you (or your
administrator) can run from the ClaroRead Program Files folder.
You can select multiple languages in the Language utility. All the languages you select will
appear in the Language drop-down list.

Advanced Settings Editor
There is a similar Language drop-down list at the bottom of the Advanced Settings Editor:

Again, some settings are specific to the language you select. For example, each language
has its own homophones, prediction dictionaries, and spelling corrections.
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About ClaroRead
Click the About button, at the bottom left of the Settings window, to show the About
ClaroRead window:

This window shows the exact version of your ClaroRead installation, as well as your system
language and licence key. Below the licence key is a “Delete licence key” button, which you
can use to deactivate ClaroRead.

Deactivating and Reactivating ClaroRead
Deactivating ClaroRead enables you to transfer ClaroRead without using up one of your
activations. When you start using a new computer, for instance.
To deactivate ClaroRead, click the About ClaroRead window’s “Delete licence key” button,
and then follow the instructions in the Claro Software Unlicenser Wizard.
The next time you run ClaroRead, you will be prompted for a valid licence key to reactivate
your ClaroRead installation. You can also activate your installation by signing into your Claro
Cloud account, or you can run ClaroRead in demo mode for a limited time.
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Advanced Settings Editor
ClaroRead’s Advanced Settings Editor contains additional configuration options including
spelling, homophone, and prediction functions.

To open the Advanced Settings Editor, click the
then select Advanced Settings Editor.

button on the ClaroRead toolbar, and

The Advanced Settings Editor has four tabs:

•

General tab – contains options for the fonts that are shown in the Font button’s menu,
and whether click-and-play is enabled. You can also export and import ClaroRead’s
settings, which helps you to move easily from one computer to another.

•

Homophones tab – shows ClaroRead’s homophones list. You can add new alternatives
or even whole new homophone pairs (or triplets, etc.).

•

Training Prediction tab – enables you to manage and edit ClaroRead’s prediction
dictionaries. This tab also contains buttons for training ClaroRead’s word prediction using
your Microsoft Word documents.

•

Spelling tab – shows ClaroRead’s list of spelling corrections. You can add words that
you commonly misspell to this list. This tab also shows a list of correction contenders,
that is, corrections that you have made using the Check window – you can choose to
promote contenders to the main corrections list, or discard them.
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General Tab
The Advanced Settings Editor’s General tab contains options for fonts and speech, as well
as buttons to export and import ClaroRead’s settings, check for updates, and help with
technical support.

Fonts and Background
This section controls the fonts that are available when you click the ClaroRead toolbar’s Font
button. Select your preferred fonts from the three drop-down lists.
Note that the “Reset background colour when exiting” check box is not used by the current
version of ClaroRead.

Speech
This section contains a single “Enable click-and-play in Internet Explorer” check box, which
is selected by default. While using Internet Explorer, you can click a paragraph in a web
page to highlight it – when you click Play, ClaroRead will read out that paragraph and
continue reading the rest of the web page.
If you deselect this check box, clicking the Play button will only read text from the start of a
web page. Note, however, that other speech features will still work if they are enabled, for
example “speak under mouse” and “speak when mouse selects”.
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Settings
The Export and Import buttons enable you to backup and restore your ClaroRead settings,
for example if you are moving to a new computer. All settings are exported to a single .zip
file, including prediction dictionaries, spelling corrections, word pronunciations, and so on.

Program
Click the “Check for updates” button to launch Claro’s update program. This shows you if
any Claro programs have new updates available.
Click the “Launch online support” button to start the TeamViewer support program. This
allows Claro Software or other technical staff to connect to your machine and help you –
note that you must be online and have arranged the support session beforehand.
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Homophones Tab
The Advanced Settings Editor’s Homophones tab enables you to view, add, edit and delete
entries in ClaroRead’s list of homophones and tricky words.

To view a homophone, simply click its entry in the list on the left side of the Homophones
tab. Details will be displayed on the right.
To edit an entry, select it from the list and click the Edit button. The Edit Entry window
appears:

Change any details you wish and click OK.
To add an entry, click the Add button on the Homophones tab, enter details in the Add Entry
window, and then click OK.
To delete an entry, select it from the list and click the Delete button.
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Training Prediction Tab
The Training Prediction tab enables you to manage and edit prediction dictionaries, as well
as training ClaroRead’s word prediction using your Microsoft Word documents.

Prediction Dictionary
Select a dictionary from the Prediction Dictionary list. ClaroRead loads the dictionary and
updates the Prediction Word List.

You can manage your dictionaries using the buttons in the Prediction Dictionary section:
•

New – create a new dictionary based on the currently selected dictionary. To create an
entirely new dictionary, first select “Empty dictionary” from the Prediction Dictionary list.

•

Rename – rename the selected dictionary.

•

Delete – delete the selected dictionary.
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Prediction Word List
This list, at the left side of the Training Prediction tab, shows all words in the selected
dictionary.

You can double-click a word to edit it, or use the buttons in this section to add or remove
words. If you hold down Ctrl and click the Remove button, ClaroRead removes all words
from the selected dictionary.
You can also export the entire prediction dictionary, with or without frequency data, or import
an entire word list from file. ClaroRead uses a tab-delimited Unicode .csv format for
dictionary files.

Train prediction dictionary using current Word doc
This section, at the right side of the Training Prediction tab, enables you to train the currently
selected dictionary from a Word document.

Click the buttons in this section to learn new words, word frequency, or word order by
analysing the currently open Word document. The analysis happens immediately, so make
sure that you have selected the correct dictionary, and have the correct Word
document open.
Note that analysing a long Word document is processor-intensive and can take a long time.
ClaroRead displays a progress bar below the three Learn buttons.
We recommend that you leave the “Spellcheck before adding” check box selected, so that
only words that are spelled correctly are added to your dictionary.
After a training action is complete, you can click the Report button to view its details, for
example the new words that have been added to your dictionary.
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Spelling Tab
The Advanced Settings Editor’s Spelling tab shows ClaroRead’s list of spelling corrections,
as well as the “contenders” that it has learned from you.

Your spelling corrections
This is ClaroRead’s list of spelling corrections, that is, the corrections that will be suggested
first in the Check window. If ClaroRead’s spelling checker finds an incorrect spelling that is in
the Word column, it will look up the corresponding entry from the Correction column and put
that at the top of the Check window’s Suggestions list.
You can add or remove word pairs from the list using the New and Delete buttons. For
example, if you often misspell “know” as “noh”, you should add “noh / know” to the list –
when ClaroRead’s spelling checker comes across the word “noh”, the suggestion “know” will
be at the top of its list.
Click the AutoCorrect button to add all your spelling corrections to Microsoft Word’s
AutoCorrect list – when you type “noh”, for example, Word will correct it to “know”
automatically. The correction words are also added to Word as a custom dictionary, so that
they will be recognised by Word’s own spelling checker.
Note that clicking AutoCorrect modifies Word’s AutoCorrect list and custom dictionary
immediately. You must close Word before you can use this feature.
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Contenders
When you make spelling corrections using the Check window, ClaroRead records them for
you to use later. These corrections are recorded as word-correction pairs in the Contenders
section of the Spelling tab.
Click the Transfer button to move the selected word pair from the Contenders list to the
“Your spelling corrections” list. That word pair will then be recognised by ClaroRead’s
spelling checker and used in the Check window.
Click the Delete button to remove the selected word pair from the Contenders list, for
example if it was a one-off correction that you are unlikely to use again. Clicking Delete All
removes all the pairs from the list.
Click the Report button to see a printable and sortable report of all your spelling corrections,
including the ones that you have deleted from the Contenders list. The report includes when
you last made each correction, how you used it, and how often you have used it.

We recommend that you check the Contenders list regularly and transfer any word pairs that
you think you will use again. This will make ClaroRead’s spelling checker work better for
you.
If you do not want ClaroRead to record your spelling corrections, deselect the “Collect
spelling data” check box.
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